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Preface
Siebel Decision Studio is a tool used to define and manage Inline Services. All aspects of Inline Services are exposed
in Studio. The target user of Studio is an IT professional having a basic knowledge of Java and a general
understanding of application development and lifecycle issues. For more information on using Studio, see Getting
Started with Siebel RTD.

Studio is a rich client application that follows an integrated development environment (IDE) paradigm. Studio makes
use of an Inline Service Explorer view on the left, and an editor view on the right. The navigator view displays a pre-
defined Inline Service folder structure. Items within each folder are Inline Service metadata elements. Using Studio,
metadata elements may be added, edited, and deleted. When a metadata element is double-clicked, the element's
details are shown in the object editor. Each metadata element type has its own editor. The elements of Studio are first
represented as XML metadata, and later Java class are generated from which the running Inline Service is compiled.

Studio is based on the Eclipse IDE. It combines features that are specific to managing Inline Services with the features
of the Eclipse IDE, which include general purpose Java development tools, integration with Software Configuration
Management (SCM) systems, etc.

This guide gives an in depth look at the concepts, components and APIs needed to use Studio to develop Inline
Services.

About this document

This document acts as a reference to Siebel Decision Studio. It identifies each of the elements used to configure Inline
Services including the properties of each and the available APIs.

Intended Audience

This document is designed to act as a reference for technical users configuring Inline Services using Siebel Decision
Studio. Users should have a basic knowledge of Java and the software development lifecycle.

How to use this guide

This document is divided into the following sections: Section 1: Siebel RTD gives an overview of the platform; Section
2: About Siebel Decision Studio Elements and APIs details each element and the callable APIs of the system;
Section 3: Siebel RTD General APIs serves as a reference for the general APIs of Siebel RTD; Section 4: About
testing and deploying an Inline Service outlines testing functionality and deploying and redeploying to the Siebel
Real-Time Decision Server; and Section 5: Troubleshooting and debugging gives tips for debugging your Inline
Service.
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Document conventions

Convention Description

monospace Indicates source code and program output.

bold Indicates portions of the user interface, including labels, tabs, menus,
etc.

italic Italics are used to highlight the first use of terms.

‘quote’ Indicates input required from the user.

Indicates additional information that may make the task easier.

Indicates additional information about the subject.

Indicates actions that may result in loss of data or errors.
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Section 1: Siebel RTD
An Inline Service is a deployable application that monitors and advises business processes at key points across the
enterprise on a real-time and continuous basis. Inline Services do not follow business processes from end-to-end, but
rather focus on specific and identified points within the process. Inline Services are configured and deployed using
Siebel Decision Studio and analyzed and tuned using Decision Center. Inline Services run on Siebel Real-Time
Decision Server. Together these components comprise Siebel RTD.

1.1 Siebel Decision Studio and Eclipse
Siebel Decision Studio is based on Eclipse, an open source Java IDE produced by the Eclipse Foundation. Siebel
Decision Studio exists as a standard plug-in to the Eclipse environment. If you are using Eclipse, you have the
advantage of using the environment for additional development and advanced features. If you aren’t familiar with
Eclipse, it is completely transparent to using Studio.

1.1.1 About the Inline Service Explorer

The Inline Service Explorer gives you access to all aspects of your Inline Service projects. A typical Inline service
project is shown below.

The folders contain the following:

Service Metadata The metadata that forms the Inline Service. The default editor for this type of
file is the editor specific to each element. You can also edit metadata in a text
editor, however this is not recommended.

classes The classes generated by the compile process.

etc This directory contains various scripts and files which are used for system
administration. If a load generator script is build it is kept in this folder by
convention.
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gensrc The generated source code files for the Inline Service.

src Custom Java code, which may include arbitrary user -provided Java classes.
Some of these classes can be used to override the default behavior of the
generated Inline Service Java classes.

lib Optionally, a lib folder is created by the user when using outside classes. For
instance, assume you want to access a class called THashMap in some
function, logic, or initialization block. This class exists in the tcollections.jar file.
To use the class, create the lib folder under the project directory in the project
workspace, and then put the tcollections.jar file in the folder. To use a class
from this jar, import using the Advanced button next to description and then
use the class in your code.

.classpath The file conta ining the project's Java classpath. There is no need to edit this
file.

.project The Eclipse project file.

1.1.2 Code Generation

In general, as elements are configured for an Inline Service, four files are produced:

 An .sda file that stores the configuration as metadata.

 A .java file that is generated from the metadata and is compiled into a class file.

 A .java file that extends the original generated file and can be used in unusual circumstances to override the
actions of the generated file.

 The class file that is first compiled from the generated file and subsequently compiled from any overrides.

The files are named in the following fashion:

 Metadata: <Object ID>.sda

 Generated: GEN<Object ID>.java

 Override: <ObjectID>.java

 Class: <ObjectID>.class

 Generated Class: GEN<ObjectID>.class

Tip: The Object ID is created as you name the object. Object IDs are
shown in the text box below the name of the object for which they are created.
The Object ID may be different from the label to conform to Java standards. To
look up an Object ID toggle between showing labels and showing Object IDs

using the toolbar button.

For instance, consider an element named Customer account . An Object ID is formed, CustomerAccount that
conforms to Java naming standards.

The files created are:
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 CustomerAccount.sda

 GENCustomerAccount.java

 CustomerAccount.java

 CustomerAccount.class

 GENCustomerAccount.class

1.1.3 About Studio Perspectives and Views

Studio allows you to work with an Inline Service from several Perspectives. A perspective defines the initial set and
layout of views and editors for the perspective. Each perspective provides a set of functionality aimed at accomplishing
a specific type of task or works with specific types of resources. Perspectives control what appears in certain menus
and toolbars.

The default Inline Service perspective contains four views:

 Inline Service Explorer view: shows the project and elements in tree form; by default on the left hand side of
the screen.

 Problem view: shows and errors and exceptions with your project; by default at the bottom of the screen.

 Test view: provides an area for testing your Inline Service; by default at the bottom of the screen.

 Cheat Sheets v iew: provides step by step instructions for common tasks; by default on the right hand side of
the screen.

The center area of the Inline Service Perspective is the editor area, and shows an editor that is specific to the node on
the project tree you have selected. To change to a new editor, double-click on the element you desire to edit.

To edit a Java file, change to the Java Perspective and double-click the Java file you wish to edit.

The Inline Service Perspective is the default Perspective and the main work area for configuring and deploying Inline
Services. Siebel RTD has a number of features for working with Inline Service metadata. These are documented
below. If there is a feature you do not see here, it is part of the core Eclipse platform, and information can be found in
the Eclipse online help document Workbench User Guide.
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The Inline Service Perspective has the following menu and toolbar items.

File→New Inline Service Project Creates a new Inline Service project in the workspace you choose.

Project→Download Downloads an already deployed Inline Service from a Siebel Real-
Time Decision Server to make changes.

Project→Deploy Deploys an Inline Service to a Siebel Real-Time Decision Server.

Window→Open Perspective→Inline 
Service Perspective

Opens an Inline Service Perspective.

Window→Show View→Inline Service
Explorer View

Shows the current Inline Serv ice View.

Window→Dispay Object IDs Toggles between showing labels and Object IDs.

Help→About Displays version information about Siebel Decision Studio.

Deploy Deploys an Inline Service to a Siebel Real-Time Decision Server.

Download Downloads an already deployed Inline Service from a Siebel Real-
Time Decision Server to make changes.

Object ID toggle Toggles between showing labels and Object IDs.

The Inline Service Explorer View has the following toolbar items.

Metadata toggle Toggles between showing the entire project tree or just Inline Service
metadata.

Collapse All Collapses the project tree.

Link with editor Finds the proper editor for the element type you have selected and
links so that when you select an element the editor adjusts
accordingly.

Menu Provides access to Link with editor and Always Show Object IDs.

Always Show Object IDs Shows both the Object ID and label of elements in the Inline Service
Explorer and the editors.

The Java perspective combines views that you would commonly use while editing Java source files, while the Debug
perspective contains the views that you would use while debugging Java programs.

To work directly with the generated Java code, use the Java Perspective. To Debug an Inline Service at the Java code
level use the Debug Perspective.
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1.1.4 Arranging views and re-sizing editors

Tabs in the editor area indicate the names of resources that are currently open for editing. An asterisk (*) indicates that
an editor has unsaved changes. Tabs on views indicate the name of the View and have a toolbar that provides
functionality specific to that View.

You may drag and drop the views and editors of a perspective to any space on the screen. Views and editors will re-
size themselves to fit the area in which they are placed. Occasionally portions of an editor (where you do your main
work) or view will become covered by other views or resized to an area that is not convenient to use. To resize the
editor or view, either close some other open views and the remaining will automatically resize, or maximize the editor
or view.

Both Editors and Views can be toggled between Maximize and Minimize by double-clicking on the tab or by using the
right click menu item. For more information on perspectives, editors and views see the online documentation provided
in the Workbench User Guide contained in the Eclipse online help.

1.1.5 About element logic

Java code is added to the logic panels of elements within Studio. This code is then inserted into the proper methods of
the GEN<ObjectID>.java file. To add logic to an element, or to update it, select the element, and use the editor to
change the code in the logic panel.

Sometimes it is more convenient to insert larger code fragments directly within the generated code. You may edit these
files directly through the Java Perspective of Studio. It is very important to note that the generated code can only be
manually edited in specific places.

Any method that can be edited via the Java Perspective in Studio is clearly marked with a Start and End marker. For
instance, the Application object has a method to initialize the Inline Service, init().

Code for this method can be added through the Studio interface via the Initialization Logic panel on the Logic tab of
the Application element.

If you choose, instead, to add your initialization code directly into the Application class using Eclipse, add it only to the
method marked as such:

public void init() {

// SDCUSTOMCODESTART.Application.InitBody.java.0

// SDCUSTOMCODEEND.Application.InitBody.java.0

}

Your code must fall between the start and end comments of the method. Any code that falls outside of the commented
areas risks being overwritten. The code added directly to a generated Java file will be lost when the file is regenerated.
To preserve the code it has to be copied back to the corresponding metadata element.

1.1.6 Overriding generated code

The generated class <ObjectID>.java extends the class GEN<ObjectID>.java. If for any reason you need to override
the code contained in GEN<ObjectID>.java, add your overriding code to the file <ObjectID>.java. This file should be
moved from the /gensrc directory to the /src directory.
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1.2 About Siebel Decision Studio Projects
Studio Inline Services are built as Projects within Siebel Decision Studio.

1.2.1 Starting a new project

To start a new Inline Service, use the File→New Inline Service Project menu to start your project. Choose a
template from the list, name your project and click Finish to create a project.

The list of templates contains templates supplied by the Siebel RTD installation, as well as any user-defined templates.

1.2.2 Importing a project

If you are opening an existing project, use the File→Import menu to import the project. If the metadata needs to be
updated from a previous version, you will be prompted to upgrade.

1.2.3 Creating a user-defined template

To create a template from an Inline Service, use File→Export to export the project to a template. Choose the export
type Inline Service Template. Templates are stored in the location defined by Inline Services Preferences. To access
preferences, use Window→Preferences and choose Inline Services. The directory entered is where your templates
are stored on the file system.

1.2.4 Downloading a deployed Inline Service

To download a deployed Inline Service, use Project→Download. You can also download it from a Siebel Real-Time
Decision Server using the download icon on the toolbar. If you are going to make changes to a deployed Inline Service,
it is important to follow these practices in order to preserve both your changes and the potential changes that have
been made by business users. Use the following method:

1. Make sure that no business users are editing the deployed Inline Service.

2. You should always lock an Inline Service when you download, so that additional changes cannot be
made by business users while you are enhancing it.

3. Make enhancements in Studio.

4. Re-deploy the Inline Service releasing the locks.

During the period that you have the Inline Service locked business users will be able to view, but not edit, the deployed
Inline Service.

1.2.5 About deployment states

When an Inline Service is deployed from Studio, you chose a deployment state from the deploy dialog. Three
deployment states are packaged with Siebel Decision Studio: Development, QA, and Deployment. Your system
administrator may add additional deployment states through JMX Administration.

When you test your Inline Service through the test view, the last deployment state is tested.

1.2.6 Example projects

A sample project is available to Import in the $INSTALLDIR\examples directory. This directory includes the Cross Sell
Inline Service that is used as an example in Integration with Siebel RTD.
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The Cross Sell Inline Service simulates a simple implementation for a credit card contact center. As calls come into the
center, information about the customer and the channel of the contact is captured.

Based on what we know of this customer, a cross selling offer is made that is presented to the customer. The success
or failure of that offer is tracked and sent back to the server so that the underlying decision model has the feedback
that helps to refine its ability to make a better cross selling recommendation.

The Cross Sell Inline Service highlights many features of Siebel RTD, including: driving the decisioning process
through Key Performance Indicators (KPIs); optimizing competing KPIs, such as reducing cost and increasing revenue;
using graphical rules-based scoring for making the right decision; and using analytical self-learning models to predict
the best decision.

It should be noted that some features displayed in the Cross Sell Project are for simulation purposes only. These are
clearly marked in the example and should not be used for production Inline Services.

The Cross Sell example can be viewed by importing the project. The project is located at
$INSTALLDIR\examples\CrossSell.

After importing the project you can view the following features by double clicking on each of the elements and viewing
the editor for that element.

Feature Element Name Description

Multiple KPIs Performance Goals The Cross Sell Inline Service is
designed to optimize both the
maximization of revenue and the
reduction of costs of the organization.

Dynamic customer data Data Source/CustomerDataSource
Entity/Customer

The combination of a Data Source
and an Entity give access to
customer data that will assist us in
making a decision of the type of offer
to present to the customer.

An Entity is an object that provides a
means to map one or more Data
Sources together into an object that
represents a significant unit in the
Inline Service.

The data accessed through the Entity
is session specific.

Cross Selling and Customer
Retention Offers

Choices The offers that are available to be
extended are organized under
Choices. Some of these offers are
designed as cross selling offers,
while others are designed to boost
customer retention rates. By viewing
the Score tab of each offer, you can
see that offers are assigned a score
for evaluation. A Score is provided for
each performance goal, Revenue
and Retention. Some offers (for
instance all Credit Cards) inherit their
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scoring from the parent Choice
Group. this indicates that all offers in
this group are scored in the same
manner. In this case the score is
calculated by the formula 'Profit
Margin multiplied by Likelihood of
Acceptance'.

Other offers (such as Reduced
Interest Rate) calculate the score
using a rule. Note that the Revenue
Goal on Reduced Interest rate is
actually scored negatively, as it
represents a loss of Revenue to the
organization.

Scoring Rules Scoring Rules/Reduced Interest Rate Scoring Rules are a way to use
session data, such as information
about the customer, to dynamically
score the offer.

Population segment Filtering Rules/Segment to Retain The population can be segmented by
using Filtering Rules. The outcome of
this rule is two groups, a group that is
eligible for customer retention offers
and the remaining group that we will
cross sell to. If a customer has
abandoned 6 or more calls and has
been a customer for over 2 years
they are filtered into a group for
retention offers.

Weighting decisions by population
segment

Decisions/OfferDecision The Decision element allows you to
weight the decision process across
the competing performance metrics.
In this case, we give priority to the
offers that score high on Customer
Retention a heavier weight for the
population segment that fits the
customer retention profile.

Integration to organizational
processes

Integration Points Integration Points are the sites that
touch outside systems and
processes, either by gathering
information (such as CallStart, which
gathers information from the IVR
about the customer) or provides
information to an outside system
(such as OfferRequest, which
provides the CRM system with the
highest scored offer for the
customer).

It should be noted that the
OfferResponse Integration Point has
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code in the else branch for
simulation purposes. In a production
situation this would be feedback from
the service center operator on
whether the offer was accepted or
not.

Warning! In order to simulate the passage of time when the Inline
Service load generation script is run, the method currentTimeMillis
has been overridden in Application.java. If you plan on using CrossSell as a
basis for a production Inline Service, you need to remove the override file
\CrossSell\src\com\sigmadynamics\sdo\Application.java.

For more about overriding generated code, see 1.3.5 Overriding generated
code above.

The Cross Sell Inline Service is ready to be deployed and loaded with data. After you deploy the Inline Service, use
Start→Programs→Siebel Analytics→RTD→Load Generator to run the script /CrossSell/etc/LoadGen.xml.

This script takes simulated customer data and runs the Inline Service. The data and correlations found can then be
viewed in Decision Center.

1.2.7 Opening Studio version 1.2 files.

If you are opening an Inline Service from a previous version of Studio, it was not created as a project. To open it as a
project, start a New Inline Service Project and then use Create project at external location to locate the files on
your file system.

This will convert the previous version Inline Service to a Studio 2.0 project.

1.3 Directory structure of Inline Services
When you create your Inline Service, you are can create your project anywhere on your file system. It is recommended
that you keep all of your projects in one directory for ease of use. The default workspace is \Documents and
Settings\<User name>\Siebel Decision Studio\.

When saving an Inline Service, the directory name is the same as your Inline Service name. The following directory
structure is created for your Inline Service.

..\<Inline Service>\classes The compiled classes of your Inline Service.

..\<Inline Service>\dc A folder for custom JSPs for Decision Center.

..\<Inline Service>\etc Load generator scripts.

..\<Inline Service>\gensrc Location of the generated source code for your Inline Service.

..\<Inline Service>\meta The metadata of your Inline Service.

..\<Inline Service>\src The source code for overriding the generated code of your Inline
Service.
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1.4 Configuring Inline Services
Inline Services are configured and deployed using Siebel Decision Studio. Elements are added to a project and Java
scriptlets with functional logic are added to certain elements. When the Inline Service is saved, XML metadata is
created to Java code is generated and deployed to the Siebel Real-Time Decision Server, where the Inline Services
runs. For more detailed information about configuring Inline Services, see Getting Started with Siebel RTD.

1.4.1 Observer Inline Services

In monitoring, Inline Services focus on collection points; points where data about the business can be gathered.
Insights and discoveries of trends and correlations in this data are made by a self learning model that predicts future
behavior and anticipates the consequences of change. This type of Inline Service is known as an Observer.

These discoveries are published to a thin client, Decision Center, where business users use these insights to make
decisions. Business users also manage and optimize the Inline Service through Decision Center.

1.4.2 Advisor Inline Services

In advising a business process, Inline Services connect at key decision points as well as collection points. Decision
points are places in the overall business process where key business decisions are made, for example product
recommendations or retention offers. Data is first gathered at collection points, discoveries are made through the self
learning model and then choices are scored according to performance metrics the organization wants to achieve. The
highest scored choice is presented by the Inline Service at the decision point in the business process. As the success
level of these choices is returned to the Inline Service via feedback, the model increases its capability of providing
better and better choices. Inline Services of this type are Advisors.
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Section 2: About Studio Elements and APIs
Siebel Decision Studio elements are configured graphically within Studio and the logic is added in the form of Java
scriptlets. The following section details each element is described below with the following information:

1. The properties of the element.

2. Any Java scriptlets the element may contain and examples of such.

2.1.1 About element Display Labels and Object IDs

As you create elements, you enter a Display Label for the element. An Object ID is automatically generated as you
type the Display Label. Object IDs are automatically made to conform to Java naming conventions: variables are mixed
case with a lowercase first letter; classes are mixed case with an uppercase first letter. If you have spaces in your label
name, they will be removed when forming the object ID. If you choose to manually enter an Object ID, you can
overwrite the Object ID that was created for you.

You can use the icon on the Inline Explorer task bar to toggle between the Display Label of the object and it's
Object ID.

2.2 Application element
When a new project is started in Studio, an Application object is created. Properties of the Application object are
defined with the following characteristics:

 Application Parameters

 Control Group

 Model Defaults

 Logic

 Permissions

All of these values are defined through the Studio interface.

2.2.1 Application Parameters

Using Debugging Options

If you are testing a deployed Inline Service against a production database, and you do not want to contaminate the
model data, you can use the debugging options to keep data from being written. Debugging options are:

 Disable learning: this option maintains the model's current state so that testing does not introduce additional
learnings.

 Disable database writes: this option keeps data from being written to the database.

Parameters Any parameters that the Inline Service requires. Parameters have a name, data type,
default value and can be made an array.

Adding Application Parameters

Application parameters are global level parameters that can be defined and stored across all sessions. A session is
defined by the session key you specify in the Application object. For instance, if you specify the CustomerId as the
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session key, whenever a new CustomorId is identified a new session is created. Sessions are closed either explicitly
by an Integration Point or when the session times out.

Use the Add button on the Application Parameter tab to add a parameter. When adding parameters you supply the
following: Name, Type, Array and Default Value.

Use the Remove button to remove parameters.

2.2.2 Application APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and Id respectively.

Application Parameter methods

When global parameters are set, getters and setters are generated in the code. To access the application parameter,
for instancemyApplicationParameter of type string, use the following:

String param = Application.getApp().getMyApplicationParameter();

Conversely, to set an application parameter:

Application.getApp().setMyApplicationParameter("my parameter");



Siebel Decision Studio Reference Guide 13

2.2.3 Configuring the Control Group

The Control Group acts as a baseline so that the business user can compare the results of the predictive model
against the pre-existing business process. It is important to define correctly the Control Group decision to tru ly reflect
the decision as it would have been made if Siebel RTD was not installed. For example, in a cross-selling Inline Service
for a call center, if no cross selling was being done before Siebel RTD was introduced, then the Control Group
Decision should return no choices.

Selection value A reference to an attribute value. This value is used to seed the Random selection of
requests for the Control Group .

If Use value literally option is turned off, then the selection value for the control group
should refer to a session key or an attribute uniquely identifying a customer. Control group
participation is determined using a pseudo random hash of the selection value. The result
of the calculation is deterministic and depends only on the selection value and the
specified size of the control group. The actual size of the control group may differ slightly
from the specified size.

If Use value literally option is turned on, then the selection value directly determines the
control group participation. The selection value in this case can be ether Boolean
(participation in control group is indicated by the true value) or integer (participation in
control group is indicated by a non zero value).

Use value literally Used when assignment of customers to control group is done outside of Siebel RTD. The
attribute used as the control group selection value has to indicate this assignment..

Percent of Population The percentage of the total number of customers that should be assigned to the control
group.

Use for analysis Controls whether the control group participation should be tracked by analytic models or
not.

Name For Analysis Name that the analytic models should use for tracking the control group participation.

2.2.4 Setting Model Defaults

Model Defaults control which model is used and how the model is setup. Most model defaults should not be changed
unless you are advised to do so by Siebel Systems technical support.

Study name The name of the study used by the Inline Service. In most cases each Inline Service
should have its own separate study. This can be achieved by keeping the name of the
study the same as the name of the Inline Service. However, an existing study may be
used when testing an Inline Service. In that case learning should be disabled to preserve
production data.

Persistence Interval The interval at which model data is saved to a database.

Time Window Duration Default value of Quarter. This feature should not be adjusted without assistance from
Siebel Systems technical support.

Start of Day Default value of 12:00 AM. This feature should not be adjusted without assistance from
Siebel Systems technical support.

First Day of Week Default value is locale dependent. In US locale it is Sunday. This feature should not be
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adjusted without assistance from Siebel Systems technical support.

First Month of Year Default value of January. This feature should not be adjusted without assistance from
Siebel Systems technical support.

Build when data
changes by

Default value of 20%. This feature should not be adjusted without assistance from Siebel
Systems technical support.

Significance threshold Default value of 25. This feature should not be adjusted without assistance from Siebel
Systems technical support.

Correlation threshold Default value of 0. This feature should not be adjusted without assistance from Siebel
Systems technical support.

Max Input Cardinality Default value of 500. This feature should not be adjusted without assistance from Siebel
Systems technical support.

Max Input Buckets Default value of 200. This feature should not be adjusted without assistance from Siebel
Systems technical support.

2.2.5 Writing Application Logic

Scriptlets to initialize and cleanup an Inline Service are added through the Studio interface via the Initialization Logic
and Cleanup Logic panels on the Logic tab of the application element.

These scriptlets are inserted into the init and cleanUp methods of the Application class. The init method is
called when the Inline Service is being loaded. The method cleanUp is called when the Inline Service is unloaded.
An active copy of the Inline Service is unloaded and the service undeployed or re-deployed.. If the application is re-
deployed,init will be called again.

2.2.6 Adding Imported Java classes

If init or cleanUp method refers to user provided Java classes, these classes may have to be imported. To add
additional import statements, use the Advanced button adjacent to the description.

2.2.7 Setting Inline Service Permissions

Inline Service permissions are set for users and groups who will be working with the Inline Service during its lifecycle.
The following permissions are available for each Inline Service and are appropriate for Inline Service developers and
Decision Center business users.

Open Service for Reading Allows Decision Center to open the Inline Service in a read-only
mode. This mode is appropriate for a business user who will use
Decision Center to view reports.

Open Service Allows the Decision Center user to edit and redeploy an Inline
Service to a Siebel Real-Time Decision Server.

Allows Decision Center to open the Inline Service. Open Service
implicitly gives permission for the user to Open Service for
Reading. This mode is appropriate for a business user who will use
Decision Center to view reports and update Inline Services.

Deploy Service From Studio Allows Studio user to deploy the Inline Service. To redeploy an
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existing Inline Service the user has to have Deploy permission for
both, the existing and the new service. This mode is appropriate for
the Inline Service developer who will use Studio to deploy Inline
Services.

Download Service Allows the Studio user to download an existing, deployed Inline
Service from a server. This mode is appropriate for the Inline
Service developer who will use Studio to deploy Inline Services.

Inline Service permissions work in conjunction with server-side Cluster Permissions to secure the Inline Service from
being changed or re-deployed by an unauthorized user. For more information on setting Cluster Permissions, see the
Installation and Administration of Siebel RTD.

Use the Permissions tab of the Application element to set Inline Service permissions. Use Add to add Users or
Groups to the Inline Service. To get Users and groups from the server, use the Get Names button. This will retrieve
Groups from the server. To see all the users, check the Show Users box.

You can choose the User or Group from the list or enter the name in the User or Group text box. Once you have
added Users or Groups, check the permissions you would like to apply under Granted.

To remove Users or Groups from the Inline Service, highlight the User or Group and use Remove.

2.3 Accessing Data
To access data within your Inline Service use the Entity, Data Source and Session elements.

Entities provide an abstract way to bring together data from multiple sources to form an object that is of use to the
overall Inline Service. Entities are comprised of a number of attributes that describe the contents of the Entity. Entities
also provide methods to access their attributes.

An Entity, such as a Customer, may combine incoming data from different sources, such as an account number
entered via an IVR and customer history retrieved from a corporate database. One of the Entity's attributes may be a
key, or unique identifier.

Data sources act as Suppliers of data. They provide a way to manage the connection to relational database tables and
stored procedures. Data sources identify columns in a database table or result sets from stored procedures as
attributes. These attributes are mapped to Entity attributes.

The Session object is a specialized Entity that identifies which attributes are available in memory to the Inline Service.
Those attributes can be comprised of a Entity, such as Customer described above, as well as attributes that are set by
some other source, such as calculation. A session object is used to store information for a user session. Attributes
stored in Session are available throughout the Inline Service and are destroyed when the session is closed.

To access data in general you will follow these steps:

1. Create a Data Source based on a SQL table or stored procedure.

2. Create an Entity with attributes from one or more data sources.

3. Add a key value to the Entity.

4. Add the Entity to the Session as an attribute and assign a session key.

5. Map the Entity attributes to data source columns or output values.

6. Map the Entity key to a session key or function.
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2.3.1 Accessing Siebel Analytics data

Siebel Analytics Server exposes ODBC client interface for accessing data stored in OLTP and OLAP databases.
Siebel RTD Decision Service uses the JDBC-ODBC bridge included in Java Runtime Environment (JRE) to connect to
ODBC driver provided by Siebel Analytics Server.

From the Siebel RTD Decision Service point of view Siebel Analytics Server is an SQL data source similar to a regular
database. Subject areas in Siebel Analytics Server are treated as database tables by the inline service. Column names
are compound, combining together two levels of the presentation object hierarchy.

For details on adding a JDBC data source that can be accessed by a Siebel Decision Studio data source, see
Configuring JDBC Data Source for Siebel Analytics in Installation and Administration of Siebel RTD.

2.3.2 About Data Sources

Data is accessed within Inline Services using the elements Data Source and Entity. A Data Source is an abstract
provider of data. Data sources act as Suppliers of data to the Inline Service.

Data sources are created entirely within Studio. There is no need to access data sources via the Java API. There are
two types of data sources: SQL Data Source and Stored Procedure Data Source.

2.3.3 Creating SQL Data Sources

SQL Data Sources are defined with the following characteristics:

Description Description of the data source.

Data Source The JNDI name of a JDBC Data Source. To create a new data source, see Installation
and Administration of Siebel RTD.

Table Name The name of the table. This name is always case insensitive, even when the database
itself is case sensitive.

Outputs Column Name The columns to select from the data source.

Outputs Type Data type of the output column.

Inputs Column Name The columns used in the where clause of the query to the data source. This is the
column or columns you will match on in order to select data from the data source.

Inputs Type Data type of the input column.

Allow multiple results Allows multiple rows to be returned. If this box is not checked and multiple rows are
returned, only the first one is used.

Advanced The Advanced button allows you to choose to show the element in Decision Center
and to change the label of the element. Changing the label of the element does not
change the Object ID.

Adding Columns to the Data Source

Use the Add or Remove buttons to add or remove columns to the data source. If you expect more than one row,
check the Allow Multiple Results box. If you do not check this and multiple rows are returned, only the first will be
used.
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Importing database column names

Use the Import button to connect directly to the data source. All of the database tables for the specified data source
will be shown. If no data source is specified, the default data source SDDS is used.

Choose the table you wish to import and the column names and data types of those columns are imported. If there are
columns you do not need, use Remove to remove them.

Setting the input column

The Input column is the column you will match on the database table to retrieve the row(s) needed for the session.
Most likely this will be a value of the primary key or a unique index column to return a single record. Otherwise, If you
have need of larger result sets, it may be a non unique indexed column. Choose the attribute that you want to match
on using Add.

2.3.4 Creating Stored Procedure Data Sources

Stored Procedure Data Sources are defined with the following characteristics:

Description Description of the data source.

Data Source The JNDI name of a JDBC Data Source

Procedure Name The name of the Stored Procedure. This name is always case insensitive, even when
the database itself is case sensitive.

Inputs and Outputs Input and output parameters for the stored procedure. Each Input and Output has a
Name, a Type and a Direction.

Result Sets The result set(s) from the stored procedure.

Allow multiple results Allows multiple results to be returned. If this box is not checked and multiple results
are returned, only the first is used.

Result Set Details The column names and type of the results expected.

Advanced The Advanced button allows you to choose to show the element in Decision Center
and to change the label of the element. Changing the label of the element does not
change the Object ID.

Adding Attributes to the Data Source

Use the Add or Remove buttons to add or remove attributes to the data source. If you expect more than one result,
check the Allow Multiple Results box. Choose whether the attribute is an Input, Output, or Input/Output.

Attributes must be ordered. Use the Up or Down buttons to order the attributes.

Adding Result Sets to the Data Source

If the Stored Procedure has a result set, use the Result Set Add button to add a result set. Use the Result Set Detail
Add button to add the column names and types of the result set. The result set columns have to be defined in the
same order they are returned by the stored procedure.
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2.4 Forming Entities
An Entity is a set of named attributes and methods to access those attributes. One attribute is usually designated as
the entity’s key. By way of example, a simple customer entity might look as follows:

In the above entity, the customerId is the key of the entity, name and age are simple attributes and accounts is a
collection of Account entities.

2.4.1 About the Session entity

One specific kind of Entity is the Session entity.

As an example of using sessions, consider a client application which is a web application, where each request supplies
the web application’s HTTP session-ID as the session key. When the first request arrives with a new HTTP session ID,
the Siebel Real-Time Decision Server will notice that this session key is new and will consequently create a new
Session object and make it available to the integration point as it executes with the request. Any subsequent requests
using the same HTTP session ID will access the same Session object.

The Session entity is automatically created for every Inline Service.

About session keys

A session key is a field passed in the request that identifies an instance of a Siebel Real-Time Decision Server server-
resident Session object that will be available to the Integration Point. The Integration Point’s execution may implicitly or
explicitly save information in the session so that it will be available to subsequently invoked integration points.
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2.4.2 Creating Entities

Entities are defined using Studio. Entity names should begin with an uppercase letter. Entities are defined with the
following characteristics:

Description Description of the entity as entered in Studio

Key A unique ID for the entity. Use the Add Key button to add a key to an entity.

Each entity attribute is defined with the following data:

Description Description of the attribute as entered in Studio

Type Attribute types are either primitive types, Java classes, entity type, Choice or

Choice Group.

Array Whether single valued or a collection.

Default value The default value, which can be a constant, a function or a reference to an

attribute.

Add attribute/key options

Use for analysis Check this box to use this attribute for analysis within the predictive model.

Category The category of the attribute. Categories help to organize the display of attributes

in Decision Center.

Analysis options Additional analysis options are available for Date attributes. To use Dates for

analysis specify the pattern you are interested in analyzing. The effect of month,

day of month, day of week and time of day can be analyzed separately or in any

combination.

2.4.3 Adding Attributes and Keys to the entity

Use the Add Attribute or Add Key buttons to add attributes to the entity. Attribute names should begin with a lower
case letter. For instance, anExampleAttributeName. If the attribute is a collection, check the column
marked Array.

Warning! When adding a Key attribute, the data type will
automatically be String. If the data type of your data source column or output
parameter is other than string, use a transformation function when you set the
input on the data source.

2.4.4 Importing attributes from a data source

To automatically add all of the attributes of a Data Source, use Import. Choose a data source to Import from. If you
would like to import from more than one data source, you can repeat the procedure. Use Remove to remove any
unwanted attributes.
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When using Import, check Build data mappings for selected data source to automatically map the attributes to the
data source. If the Entity is nested (for example, in a one-to-many relationship) and the attributes are mapped
indirectly, uncheck this option.

2.4.5 Using attributes for analysis

Check Use for Analysis to have the attribute added to the analytical model.

2.4.6 Decision Center display

Show in Decision Center is checked by default. Uncheck the box if you want the attribute to be hidden from Decision
Center users. Choose a Category to control the display of the attribute in Decision Center.

2.4.7 Transforming non-string data for key values

If the attribute to be mapped to the key value of the Entity is not of type String, you must write a transformation function
to transform the value. Follow these steps to make the key value a string.

1 Create a new Function. The input type is the type of your existing data; the output type is
String.

2 Write the function body to convert the data to string. For instance, if your data was originally
an integer:

int i;

String str = Integer.toString(i);

return str;

3 At the Integration Point where you get your session key value, for the incoming parameter that
is your session key, click in the session attribute column to get the icon. Choose your
attribute from the list and use Transform Data to choose the transformation function that was
written.

4 In Assignment use the Transformation Function menu to locate our transformation
function.

2.4.8 Adding a session key

If the session key value that you choose to use is an attribute of an Entity, first add the Entity to the Session. To do
this, use Add attribute to add a new attribute.

For instance, assume you want to make the session key the 'customerID' attribute from the Customer entity. Use Add
Attribute to add an attribute to the Session called 'customer'. The type of this attribute is an entity type, namely
'Customer'.

To access the entity types use the pull down menu on the Type column and choose Others. The Type window will
appear. Choose the Entity Type for this attribute.

To add the session key use the Select button from Session Keys from Dependent Entities. All keys values from
Entities that are attributes of the Session are available to be chosen as a key value for the Session. Choose the key
that you would like to base the session on, in this instance 'customerID'.
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Note: The keys of cached entities cannot be used as session keys.

To add a session key that is not from a dependent entity, use Add Key. Once you have added the key, click in Default
value to map the key to a attribute, constant or function call.

2.4.9 Adding attributes to the Session

Use Add Attribute to add an attribute that you would like to make available for the entire session. Session attributes
have getters and setters generated for them, just as do other entity attributes.

2.4.10 Mapping attributes to data sources

After creating an Entity using Studio, you map the Entities attributes to values that are either constant, calculated, a
reference to an attribute of a data source or to the session key.

Mapping is done via the Mapping tab of the Entity object. To map the attributes of an entity to a data source use the
Source column to choose the path to the data source column or output parameter that will supply the attribute with
data.

To map the Key value use the Input Value from Data Source Input Values. Your key value will appear here when you
map the attributes to data source values. You may map the key to an Session key attribute, to another Entity key value
or to a function. The Input type must be of type String. If it is not, use a function to transform the non-string value.

2.4.11 One to many relationships

To access data in an Entity in a one to many foreign key relationship you make the related entity an attribute of the first
Entity. For example, take the following relationship:

The Customers table has a key, CustomerID. Customers have many Orders, which are identified by OrderID and a
foreign key CustomerID.

1 In Studio, define a data source for each of these tables.

2 Create an Entity for Customers and Orders.

3 Add Customer to the Session, as that is the key to retrieving the next
level of data.

4 Choose 'CustomerID' as the session key.

5 To associate the one-to-many relationship between Orders and
Customers, add an attribute to Customer called Orders, of entity type
"Orders". Since there are many Orders for one Customer, make it an
array.

6 You can map all of the attribute values through the Customer entity mapping tab.

2.4.12 Adding Imported Java classes

To add imported Java classes to your Inline Service, use the Advanced button adjacent to description.

2.4.13 Session Logic

The Session element can accept scriptlets that are executed on initialization and exit of the session. The cleanup
scriptlet is executed either when the session is forced closed or when it times out.
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2.4.14 Session APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and ID respectively.

You can usesession()to access the other entities of the Inline Service. For example,

session().getCustomer().getCustomerId();

where Customer is an entity and customerId is an attribute of that entity.

Usesession()to access the instance of the application session. Session has the following APIs available:

public boolean isTemporary();

If no session keys have been passed in, the session is considered temporary.

public IntegrationPointRequestInterface getRequest();

Used to access an Integration Point request outside of the Integration Point. Returns the current request.

boolean isClosed();

Returns whether the current instance of the session has been closed.

Set getKeys();

Returns any known session keys. This may or may not be the complete set depending on where it is called.

public void close();

Close the current session instance.

public ApplicationInterface getApp();

Gets the application object of the current session.

2.4.15 Entity APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and Id respectively.

2.4.16 About Entity Classes

In addition to the normal the classes generated, an array class is also generated for each entity created. The
generated classes have a property, getter, and setter, for each attribute. Hence, the definition of entities such as
Customer, Account, and Call will result in classes with these names as well as another class, representing a collection
of that class.
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For instance, take the Account entity. The following two classes are generated:

Account

SDAccountArray

The latter represents a collection of Accounts. So, when our Customer entity has an attribute named accounts of type
Account (with multiplicity set to multiple), then the following gets generated for Customer:

Customer {

SDAccountArray getAccounts() {

}

void setAccounts(SDAccountArray accounts) {

}

void addToAccounts(Account account) {

}

}

2.4.17 Creating entities

Because a class is generated for each entity type, you create an entity with the new operator as you would any Java
object. For example:

Customer cust = new Customer();

Optionally, if the entity is the child of another entity, pass in the parent entity's name. Session can be a parent entity of
any of the other entities.

Customer cust = new Customer(entityParent);

2.4.18 Adding entity keys

Most entities aren’t very useful without having a value for the key attribute. The key attribute, as with any attribute, is
set using a generated setter:

Customer cust = new Customer();

cust.setCustomerId(newKey);

2.4.19 Accessing entity attributes

As mentioned already, getters are generated for each attribute. The form of the getter depends on whether the attribute
has one value or more than one value. Our sample Customer entity would have the following getters:

String id = cust.getCustomerId();

String name = cust.getName();

double age = cust.getAge();

Collection accounts = cust.getAccounts();

Corresponding setters are also generated. We’ve already seen the setter for customerId but here are the others
for our Customer example:



Siebel Decision Studio Reference Guide 24

cust.setName(“Fred Johnson”);

cust.setAge(42);

cust.setAccounts(newCollection);

and, because Accounts is an attribute that has multiple values, you can also add to the collection:

cust.addToAccounts(anotherAccountObject);

an array can be added using

cust.addAllAccounts(anotherAccountArray);

2.4.20 Resetting and filling an entity

Three special methods are provided to reset and to fill an entity.

cust.reset();

Resets all keys except session keys and all attributes.

cust.reset();

Resets all attributes, but doesn't reset keys.

cust.fill();

Fill recursively fills the values of the attributes according to the entity mapping, forcing it to refresh the data through the
data source, calculated or constant value. Any attributes of entity type are also filled.

Reset and fill should not be called on cached entities.

2.4.21 About cached entities

Entities can be cached on the server so that they are easily accessible. To cache entities, use the Cache tab of the
entity.

Cache has the following characteristics:

Enable caching for this
entity type

Check this box to enable caching. Cached entities are treated exactly like non-
cached entities and have the same API, except that cached Entity keys may not
be used as session keys.

Max number of items to
cache

The maximum number of items to cache. Items are flushed in a first in – first out
manner.

Caching strategy

Use fixed lifetime Number of seconds each object stays in cache before being refreshed.

Use fixed period Number of seconds before entire cache is refreshed.

Never refresh cache Cached items stay in cache until max number is reached.

If an entity is marked for caching, use the following to set the attributes. Once you create the entity set the key values
and then get the attribute values from the cache. Cached entity attributes (other than the key) do not have setters. This
keeps the entity in sync with the cached version.

Customer cust = new Customer();
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cust.setCustomerId(newKey);

cust.getCustomerId();

cust.getName();

cust.getAge();

cust.getAccounts();

2.5 The Decisioning Process
The decisioning process is based on a framework that takes into account the overall performance goals that an
organization is concerned with, the performance metrics that measure those goals, the action required to score each of
the available choices and a weighting of that score based on segments of the population.

The following elements are part of this framework:

1. Performance Goal

2. Decisions

3. Choice Groups

4. Choices

5. Filtering Rules

6. Scoring Rules

7. Predictive Models

2.6 Performance Goals
In designing a decision process for an organization, first consider the overall Performance Goals of the organization.
Performance Goals are comprised of the specific metrics with which the organization has chosen to measure their
success. Some common performance metrics are:

 Revenue

 Costs

 Number of products per customer

 Customer satisfaction

The performance metrics are configured with an optimization direction (maximize or minimize) and a normalization
quotient.

Performance Goals have the following characteristics:

Performance metric Metrics with which the organization has chosen to measure their success that
relate to the overall goals of the organization

Optimization A value, Minimize or Maximize, that indicates the direction in which to optimize
the performance metric

Required Check if scoring for the performance metric is required. If a metric is not marked
required, and a score is not available through lack of data, Siebel RTD can
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provide a score by examining other scores. If it is marked required, a general
score will not be provided and the metric is marked not available and dropped
from the scoring process.

Normalization factor The relative value to the organization of this performance metric.

2.6.1 Adding a performance metric

Use the Add button to add performance metrics. Add a metric (for example, revenue), an optimization direction
(maximize) and whether the metric is required to have scores available for a decision to be made.

Once you have added all of your metrics, you must decide on the Normalization Factor.

2.6.2 Calculating a normalization factor

The normalization factor represents the relative value to the organization. Many times the the performance metrics are
not measured on the same scale. For instance, churn is measured by number of customers who turnover, while
revenue is measured in dollars. If a churn metric and revenue metric were part of the same performance goal, you
must find some leveling factor for them. If, for example, you know that the loss of one customer costs your organization
$500, the you would use 500 as a normalization factor and mark the the churn metric as 'Minimize'.

2.7 Choice Groups and Choices
Choice Groups and Choices are elements that allow the selection of one or more choices among a number of possible
choices. The Choice is either returned to a Decision, so that it can be return by an Advisor, or it is registered with a
Model by an Informant. The process of selecting choices is divided into the following computations:

1. Eligibility: Eligibility is a set of rules that determines whether or not a choice is available to be selected for the
decision.

2. Scoring: Scoring is the computation of a score along each Key Performance Indicator (KPI) as defined by the
performance metrics. A score assigns a numerical value to the expected effect a choice will have for a given
performance metric if selected.

3. Normalization: Normalization brings the scores along the different performance metrics to a common scale
that enables the comparison of scores.

4. Totaling: Totaling produces a single number for each Choice. This number can be used to compare the
relative benefit of each Choice.

5. Selection: Selection determines which Choices are to be used. Selection usually applies to the totals
computed in “totaling.”

2.7.1 About Choice Groups and Choices

Choices and Choice Groups have the following:

Attribute values The attributes that make up the choice. These can be inherited from the parent Choice
Group or assigned at the Choice level.

Scores Each choice will be scored according to the definition in the Scores tab. Choices are
score against all of the performance metrics that are contained in Performance Goals.

Choice Events Choice Events are only described at the Group level. These events are defined about
the lifecycle surrounding a Choice. For instance, a Cross Selling Offer made may have
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events such as 'Offered', 'Accepted', and 'Product First Used'.

Rules Rules affect whether a Choice is able to be considered for Scoring and an ultimate
Decision. A rule may be altered by Decision Center users.

Advanced The Advanced button allows you to choose to show the element in Decision Center
and to change the label of the element. Changing the label of the element does not
change the Object ID.

2.7.2 About Choice Attributes

Choice attributes have the following characteristics:

Name The name of the attribute.

Category The category the attribute belongs too. Categories are defined by the Category
element.

Type Data type of the attribute.

Array Whether the attribute is a collection.

Inherited Value The value, if any, that the Choice Group or Choice attribute has inherited from its
parent.

Value The value of the attribute. This value always overrides and inherited value.

Show in Decision Center Check to make the attribute visible to business users in Decision Center.
Uncheck for internally used attributes.

Use for indexing Check if you want to be able to look up the Choice by the attribute specified.
Assume you have a choice attribute called 'name'. A static method is generated
on the choice group called:

getChoiceWithName(String name)

This method returns a choice.

Send to client Check this if the attribute will be sent to the outside client calling the Inline
Service that returns this choice.

2.7.3 Adding Choice attributes

To add or remove Choice attributes, use the Add and Remove buttons. To edit a Choice attribute right -click on the
attribute and use Properties. You can only edit Choice attributes at the highest level that they are defined.

2.7.4 About Choice Group attributes

Choice Group attributes are used to allow flexible group level rules. Group Attributes apply only at the Choice Group
level and so are not assignable for individual Choices.
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2.7.5 About Choice attributes

Choice attributes define the choice. Choice attributes are set at the Choice group level so that each choice in a group
has the same set of attributes, and then they are individually defined at the choice level. Choice attributes may have
default values that can be set and overridden at lower levels.

Choice Groups and Choices are defined hierarchically. The hierarchy should follow the logical taxonomy of the
choices. At the top level it is necessary to consider the definition of Choice Attributes that make sense for a whole sub-
tree. At lower levels the shape of the hierarchy is more typically determined by organizational issues.

Choice Attributes are defined typically at the higher levels of the hierarchy. Some attributes have a default value that
may be marked as non-overrideable, which means that the value provided by default is the value that will be used. This
is typically done when computations are involved. This is useful when you do not want a business user to update the
attribute after deployment.

Choice values can be constant, attribute or variable, a function call or predictive. A predictive attribute is calculated by
the model at run time and used as a scoring device to select the proper Choice by the Decision or other logic.
Predictive attributes have no default value.

As an example, examine this choice group:

The Choice attributes set at the Offers level are:

Attribute Type Value

Message String No default value. Values assigned at
choice level for each choice.

ShouldRespondPositively Boolean The function
ShouldRespondPositively() that
returns a Boolean value about
whether a customer will respond
positively to a given choice.

likelihood Predictive/Double A placeholder attribute that is
assigned by the model. Used for
likelihood that the choice will be
accepted. There is no default value
as this is calculated at runtime.

Profit Margin Double Default value of 0.5. Values assigned
at choice level for each choice.
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Each Choice overrides the Profit Margin and Message values with a value that is indicative of that Choice. However,
the default value will be available at runtime in case the server cannot respond in an effective time period.

No choices override the ShouldRespondPositively attribute as they all use the same function to determine that value.
The likelihood is calculated by the model for each choice at runtime.

There is another attribute at the group level. It is a Group Attribute.

Attribute Type Value

averageLikelihood Predictive/Double An attribute used by the model as an
average of likelihoods across all
choices. Used as a likelihood if a
likelihood for a given choice is not
available. There is no default value
as this is calculated at runtime.

2.7.6 About choice scoring

Choice Groups and Choices inherit scoring from their parents. In scoring the Choice or Choice Group, you identify the
performance metric(s) that apply to that choice and then apply a scoring method to it. Scoring Methods can be a
Scoring Rule, Function, Constant or the likelihood of an event occurring on a Choice Event Model.

So for instance, assume a Choice Group structure described above, some of the Choices may have scoring similar to:

Mileage Plus Card

Performance Metric Score

Increase Revenue A function that uses the likelihood of the
customer to accept the offer and the
expected profit margin of the card to
calculate the revenue potential of the
offer. The likelihood is computed by a
model.

Gold Card

Performance Metric Score

Increase Revenue An inherited constant from the choice
group level.

Credit analysis

Performance Metric Score

Increase customer retention A scoring rule that uses customer data to
assign a score.
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Scoring must return a double data type, but more importantly must conceptually match the normalization rate given to
the performance metric in the performance goal. For example if that leveling factor was between dollars and dollars,
the functions must return a value representing dollars.

2.7.7 About eligibility rules

Choices and Choice Groups have Rules that determine their eligibility to participate in the decision. The rule
determines whether the choice is eligible to participate in the Selection Function or Rule of the Decision or logic that
makes the Choice selection. The group level rules are found on the Choice Eligibility and Group Eligibility tabs of
the Choice Group editor. Choice level rules are found on the Eligibility Rule tab of the Choice editor.

The rule determines whether the sub-tree headed by a Choice Group or a Choice is eligible for a decision. Note that
even if Choices themselves are eligible, they will not be eligible unless all their ancestors are eligible.

For directions on how to use the editors for these rules, see 2.10
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Using Rule Editors.

2.7.8 Evaluating Choice Group rules and Choice eligibility rules

Choice Group rules and Choice rules are inherited and additive. That is, if there are rules at the Choice Group (Group
and Choice rule) and rules at the Choice level, it is as if there is a logical AND extending the rules. The inherited rules
are shown in an expandable section at the top of the rule labeled Inherited eligibility conditions. Use the buttons

and to expand and collapse the sections.

Take the following instance:

Group1 has rules GroupRule1 and ChoiceRule1

Group2 is a child ofGroup1 and has rules GroupRule2 and ChoiceRule2

Group2 has a Choice, Choice1, and it has a rule, Rule1

In evaluating the rules for Choice1, the following rules will be invoked:

GroupRule1 AND GroupRule2 AND ChoiceRule1 AND ChoiceRule2 AND Rule1

2.7.9 Determining eligibility

When determining eligibility for a choice, the choice rule is first tested on the Choice. Then, if the Choice is eligible, the
parent rules are tested using super.isEligible(). It is important to note that we do not test with
this.getParent().isEligible() because that would test the parent for eligibility, not the Choice.

Eligibility for the following Choice:

Group1 has rule GroupRule1

Group2 is a child ofGroup1 and has rule GroupRule2

Group2 has a Choice, Choice1, and it has a rule, Rule1

would be determined in the following manner:

If Choice1 is eligible with Rule1 test with GroupRule2

if eligible test with GroupRule1

2.7.10 Choice Group APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and Id respectively.

public Choice getChoice(String internalNameOfChoice);

Returns a Choice object from the Choice Group.

public Choice getChoiceWithAttributeID(AttributeType val);
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When a choice attribute is marked for indexing, this method is used to return the choice as referenced by the indexed
attribute.

2.7.11 Choice APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and Id respectively.

To get the Choice Group that the Choice is contained in, use:

public ChoiceGroup getGroup();

Choice event tracking API consists of two methods defined on choices:

void recordEvent(String eventName);

void recordEvent(String eventName, String channel);

Typical code for an Integration Point recording a choice event would be:

String choiceName = request.getChoiceName();

String choiceOutcome = request.getChoiceOutcome();

ChoiceGroup.getChoice(choiceName).recordEvent(choiceOutcome);

Tracking of extended and accepted offers is required by many Inline Services for eligibility rules that depend on
previous offers extended to or accepted by the same customer in the past.

Two kinds of questions, both related to a particular customer, can be answered by the choice event history:

 How long ago was an offer extended or accepted?

 How many times was an offer extended or accepted during a given recent time period?

The answers to these questions are provided by API methods defined on choices and choice groups:

int daysSinceLastEvent(String eventName);

int daysSinceLastEvent(String eventName, String channel);

int numberOfEventsDuringLastNDays(String eventName, int numberOfDays);

int numberOfEventsDuringLastNDays(String eventName, int numberOfDays,
String channel);

2.8 Filtering Rules
Filtering rules are available as stand alone rules; they are identical in usage to Eligibility Rules that are associated with
Choices or Choice Groups. Their main function is to segment the population for which Decisions are being made. For
more about Eligibility Rules, see section 2.7.7 About eligibility rules.

For information on editing rules, see 2.10



Siebel Decision Studio Reference Guide 33

Using Rule Editors.

2.8.1 Using Filtering Rules to Segment Population

Filtering rules are used to segment the population. This in turn is used by the Decision to apply performance metrics to
different segments of the population. A typical rule used to segment population may be as shown below:

This rule targets customers over the age of 18 with a credit line amount over $8000. Filtering rules are used by
Decisions.

2.9 Scoring Rules
Scoring rules are available as stand-lone rules to be used by a Choice to assign a Score. Scoring Rules are very
similar in function to Eligibility Rules on Choices. For more on using the Rule editor, see 2.10:
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Using Rule Editors .

In addition to the functionality that Filtering Rules have, Scoring Rules evaluate to a numeric score, in the form of a
double. Scoring Rules have a default value if none of the rule segments evaluate to true.

To add a value, click under Then or The value is in the Value column. Edit Value appears and then on the ellipsis
. edit the value as you would any other rule value.

For instance, the Scoring Rule below assigns scores based on a customer's credit line amount. If they fit into none of
the credit line range categories, the score defaults to 3.

Description Scoring Rules can be adjusted by Decision Center users, so it is very important to
describe your scoring rule adequately. It is suggested that you include the range that
the score is to work over.

Advanced The Advanced button allows you to choose to show the element in Decision Center
and to change the label of the element. Changing the label of the element does not
change the Object ID.
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2.10 Using Rule Editors
Rules are used for several purposes within Siebel Decision Studio and Siebel Decision Center: for determining the
eligibility of Choice Groups and Choices to take part in a Decision; as stand alone, re-usable rules for Filtering
population segments; and, as stand alone, re-usable rules for scoring Choices.

The Rule editor toolbar provides access to features used to edit rules. This toolbar is sensitive to the context of the task
you are performing. A right-click context sensitive menu is also available with these functions.

The functions from left to right are:

 Edit rule properties

 Add Rule

 Add Ruleset

 Delete

 Invert

 Move up

 Move down

 Copy selection to clipboard

 Cut selection to clipboard

 Paste from clipboard

The editors that are used to create rules are very similar. The following section describes how to create rules using
these editors.

2.10.1 Adding rules

Add a rule using the Add Rule button. There are two types of rule segments to add: Rules and Rule Sets. By
default rules are two operand rules. To change to a single operand rule, click the rule's number to select it. Click the

in the corner of the operand to choose between single and double operands. Single operands always evaluate as a
Boolean.

About logical operators

There are four logical operators for a set of rules:

 All of the following (logical and). The Logical Expression will be true when all of its child expressions are
satisfied.

 Any of the following (logical or). The Logical Expression will be true when any one of its children is true.

 None of the following (logical not and). The Logical Expression will be true when all of its child expressions
are false.

 Not all of the following (logical not or). The Logical Expression will be true when any one of its child
expressions are false.

You can change the value of the Logical Operator by selecting it, clicking on and selecting another one from the popup
menu that appears.



Siebel Decision Studio Reference Guide 36

Editing rule properties

Both Filtering and Scoring rules have Rule properties that can be set. To edit rule properties, click the Rule properties
button. Edit rule properties appears.

Rule properties include call templates and negative call templates. Call templates provide a user friendly way to
describe how to call a rule from another rule.

To define a call template, add the number of parameters for the rule using the Add button under Parameters. Using
{0}, {1}, and so on as arguments, and phrasing to describe the rule, define the template for call. It is important to use
good phrasing as this is what will be shown when using the rule.

For instance, a rule that checks how many calls that have come in from a user in the last x number of days, could be
phrased as such:

{0} calls in last {1} days

The negative call template is used when a rule is inverted, and should express the opposite:

Not {0} calls in the last {1} days

Rule properties also allow you to assign which Choice Group to use with the rule. By checking Use with choice group
you can specify which Choice Group or its Choices will provide the Choice attributes for use by parameters. These
attributes will be available when you edit the value of an operand.

Selecting an operator

Click on the operator and click on the lower right corner and select an operator.

The following operators are available:

none A Simple Expression that only has one operand

= Left is equal to Right

≠ Left is not equal to Right

< Left is less than Right

<= Left is less than or equal to Right

> Left is greater than Right

>= Left is greater than or equal to Right

in Left value is contained in a List on the Right side

not in Left value is not contained in a List on the Right side

includes all of Left list includes all of the values of the Right list

excludes all of Left list contains none of the values of the Right list



Siebel Decision Studio Reference Guide 37

includes any of Left list includes any one of the values of the Right list

does not include all of Left list does not include all of the values of the list on the
Right

Editing the value of a rule element

To edit the elements of the rule, click on the left side and then on the ellipsis . Edit Value appears. You may
choose from a constant, attribute or function call. Check Array at the top of the page to specify an array value.

If you choose Constant provide:

Data type The data type of the item.

Value A constant value.

If you have checked Array, add as many items to the array as needed and then choose a dataype and provide a value
for each.

If you choose Attribute provide one of the following:

Group attribute Attributes that are part of the Choice Group or its Choices
that is selected in the Properties of the rule.

Session attribute Attributes that are part of the Session entity.

Application attribute Attributes that are a member of the Application element.

Optionally, check Apply filter type and choose a Data type to filter the attributes by type. If you have checked Array,
add as many items to the array as needed and then assign an attribute value for each.

If you choose Function call provide one of the following:

Filtering rules Stand-alone filtering rules defined for the Inline Service.

Scoring rules Stand-alone scoring rules defined for the Inline Service.

Function calls Stand-alone functions defined for the Inline Service.

Optionally, check Apply filter type and choose a Data type to filter the attributes by type. If you have checked Array,
add as many items to the array as needed and then assign a function or rule for each.

Adding a Ruleset

Click the Add Ruleset button. A new group of rules appears in the expression. By default it is an All of the
following expression. To change the expression, click on the right corner and change it to the expression you wish.

Inverting a rule

Using the Invert button, you can invert different elements of the rule. By selecting the number of a rule segment,
you can invert the operator of a rule. For instance, if the rule operand was '=', it will be inverted to '<>'.
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Logical operator for a rule can also be inverted. Select the logical operator and use Invert. For instance 'All of the
following' becomes 'Not all of the following'.

The final use for Invert is to invert a Boolean, or single operand, rule. When this type of rule is inverted, it is
transformed to the negative call template of the function that defines the rule.

2.11 About the Decision Process
Decisions are called by Advisors to score Choices according to their functions or rules and return one or more Choices
from a Choice Group. The setup of a decision must include at least one Choice Group from which choices are
selected, and a function or rule to score the choices. At run time, the Decision collects all the eligible choices that are in
the sub-trees of the configured Choice Groups. Then the choices are scored to finally select a number of choices.

Examples of scores include:

 Likelihood of being interested

 Expected business benefit in dollars

 Expected time savings

Alternatively, a custom selection function can be written to select the choice.

A Decision is typically used to select one or more choices out of a group of eligible choices. The most common use is
within an Advisor which refers to two decisions, one for the regular processing and one for the control group.

Selection Criteria

Select Choice from Used to assign the Choice Group or Groups that will be considered by the Decision.

Number of Choices to
Select

Indicates the number of choices that will be selected by the decision. The default and
most commonly used number is 1. This is the maximum number and the actual number of
choices returned at runtime may be smaller or equal to this number.

Select at random Assigns random selection of a Choice from the Choice Group(s). This is used primarily for
a Control Group Decision.

Target Segments Segment of the population that have been segmented using Filtering Rules. The default
segment is everyone.

Priorities Used to set the priorities for different segments by weighting performance metrics that
apply to those segments.

To add a Choice Group use Select and select the Choice Group or Groups to use.

2.11.1 Segmenting population and weighting goals

Decisions can also target segments of the population and weight the performance metrics attached to that Decision for
each segment. To add or remove a Segment, use Add and Remove. Use Add to add performance metrics to
Priorities.

For instance, assume the Decision 'Select Best Offer' has two performance goals: 'Customer Retention' and 'Revenue'.
We have also defined a segment of the population: People to retain that we have defined via Filtering Rules. The
default remainder is the segment that we will cross sell to.

The weighting is for each performance goal and for each segment:
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Customer Retention 20%
People to sell to

Revenue 80%

Customer Retention 90%
default

Revenue 10%

When the Decision is invoked, the performance metric scoring (whether function, scoring rule, function, etc.) is applied
to all of the eligible Choices. Scores are leveled using the normalization factor of the performance metrics. Scores are
then weighted according to performance metric weighting contained in the decision. A total score is achieved and the
Choice with the highest score is decided on.

2.11.2 Using a custom selection function

If, instead of scoring, you would like to use a custom Selection Function, check the Custom Selection Function box
on the Custom Selection Function tab. Choose the Selection Function from the list, and add any parameters that the
function requires.

2.11.3 Pre/Post Selection Logic

Scriptlets in the Pre and Post Selection tab are executed before or after the scoring is done and the Decision is made.
These scriptlets typically modify the choices in some way or do recording of facts.

Pre-selection logic is executed after collecting all the eligible choices but before the selection happens. Post-selection
logic is executed after the selection but before the selected choices are returned. Post-selection logic is more common.
You can use this to record the Decision made or further process the Decision.

The logic here can use the variables defined for the computation of the choices. For example, the name of the choice
array, which contains eligible choices before and selected choices after the selection, is set in the "Pre/Post Selection"
tab (by default 'choices').

Decision returns a choiceArray. To access the individual elements, use an index into the array. The following
example reads the choiceArray, and records the base event “Delivered” to the Choice Event Model. The method
choice.recordEvent calls the model recordEvent, passing in the choice to be recorded.

// SDCUSTOMCODESTART.<Classname>.PostSelectionBody.java.0

for (int i = 0; i < outputChoiceArray.size(); i++) {

Choice choice = outputChoiceArray.get(i);

choice.recordEvent("Delivered");

}

session().addAllToPresentedOffers(outputChoiceArray); /* Store
presented offers for future reference */

// SDCUSTOMCODEEND.<Classname>.PostSelectionBody.java.0
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2.11.4 Selection Function APIs

The type of weights parameter is GoalValues. The GoalValues class has agetValue method for each of the goals
defined in the Decision. For example in, if there are goals 'CustomerRetention' and 'Revenue' it has the following
methods:

public double getValueForCustomerRetention();

public double getValueForRevenue();

2.11.5 Adding Imported Java classes and Changing Decision Center Display

To add imported Java classes to your Inline Service, use the Advanced button adjacent to description. You may also
change the display label for Decision Center and choose whether the element is displayed in the Decision Center
Navigator. Changing the display label does not affect the Object ID.

2.12 About Selection Functions
As an alternative, a Selection Function can be used by a Decision. Selection Functions are like functions in that they
are completely user defined. However, Selection Functions have a well defined signature. They take a choice array as
input and return a choice array.

Selection Functions have the following characteristics:

Description Description of the selection function

Primary Parameters

Input Choice Array The input parameter to the selection function. The data type of this variable is
SDChoiceArray.

Output Choice Array The return variable which specifies the name of the variable that contains the selected
choices and should be returned to the caller of this selection function. The return
variable can be the Input Choices Array that is passed in to this selection function or it
can be another variable defined locally within the Logic panel. The data type of this
variable is SDChoiceArray.

Number of Choices
Parameter

The name of the function argument that represents the number of choices that the
selection function should return. The default name of the parameter is numChoices.
The data type of this argument is 'int'.

Weights If goals are defined for the Decision that uses this selection function, those goal are
passed to the Selection function under the parameter named in Weights. The type is a
GoalValue. For more about GoalValue, see the section on Decisions.

Extra Parameters Any extra parameters the selection function need.

Selection Function Scriptlets

Selection Functions are used as a custom function for selection criteria. Many standard priority functions are available
via templates. Priorities or Selection Functions are defined in Java. A set of these are predefined in the template and
usually either fill in the need or provide an advanced prototype to modify.
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Java code that does the actual selection of choices from the list passed in as Input Choices Array is entered in the
Logic pane. Often, the java code in the Logic section will want to refer to other classes. For the java code and the
function to compile correctly, the classes need to be imported into the function.

The execute method executes the selection function.

A simple example of a selection function is shown below:

double maxL = -1.0;

Choice ch = null;

for (int i = 0; i < eligibleChoices.size(); i++) {

Cross_Selling_OfferChoice cso =
(Cross_Selling_OfferChoice)eligibleChoices.get(i);

double likelihood = cso.getLikelihood();

if (ch == null || (!Double.isNaN(likelihood) && likelihood > maxL)) {

maxL = likelihood;

ch = cso;

}

}

SDChoiceArray selectedChoices = new SDChoiceArray(1);

if (ch != null)

selectedChoices.add(ch);

2.12.1 Adding Imported Java classes and Changing Decision Center Display

To add imported Java classes to your Inline Service, use the Advanced button adjacent to description. You may also
change the display label for Decision Center and choose whether the element is displayed in the Decision Center
Navigator. Changing the display label does not affect the Object ID.

2.13 About Inline Analytic Models
Analytic models serve two primary goals -- online prediction of business process parameters and offline analysis of
data.

For online prediction of business process parameters, models are attached to Choices and are used to predict the
result of selecting a Choice with respect to a specific Key Performance Indicator (KPI).

For offline analysis, models are used to analyze the Choice targets that provide analytical data to Decision Center
reports.

The main partitioning attribute for a Model is typically the Choice. Additional partitioning attributes can be used to
achieve strong differentiation between separate situations or populations. For example, the channel used in the
interaction in a customer contact or the country of the customer can be used as partitioning attributes. Partitioning
attributes should be used judiciously as they multiply the amount of memory required by the Model.
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2.13.1 Type of Models

There are three types of models:

Choice Models: Choice Models are used for data analysis on a set of mutually exclusive options. For instance,
analyzing the reason for calls into a call center uses a Choice Model.

Choice Event Models: Choice Event Models are specifically designed to track choices for self learning. Choice
events are events that relate to a particular choice that is either internal or external to an Inline Service.

Models: A generic non specific model. This model should only be used for special purposes.

2.13.2 Model attributes

The Choice tab and the Attributes tab of Choice and Choice Event Models differ.

Attributes of the Choice tab and the Attributes tab of the Choice Model are:

Choice

Choice Group The name of the choice group the model applies to.

Label for Choice The label for the Choice Group

Mutually Exclusive Check if the choices are to be mutually exclusive.

Attributes

Partitioning attributes Each analytic model consists of a number of sub-models, each corresponding to
a separate combination of values of partitioning attributes.

A decision to make an attribute a partitioning one has to be based on a radical
difference in predicted likelihood depending on the value of the attribute in
question. Attributes that have moderate effect on predicted results should be
treated as regular input, not as partitioning. The Model size is very sensitive to
cardinality of partitioning attributes. Two partitioning attributes with cardinality 10
each would result in a model 25 times larger than the one that would be
produced if each of the partitioning attribute had cardinality 2.

Excluded attributes By default all session and entity attributes are used as model inputs. To prohibit
the model from using some attributes as inputs you can add them to the
Excluded Attributes list. Note to exclude an entity attribute from all models, it is
easier to do by turning off Use for analysis option in the properties of the
attribute itself.

Aggregate by By choosing one of the partitioning attributes, you can create additional sub-
models for learning on the attribute. As with partitioning, a decision to aggregate
on an attribute has to be based on a radical difference in predicted likelihood
depending on the value of the attribute in question.

Attributes of a Choice tab and the Attributes tab of the Choice Event Model are:

Choice



Siebel Decision Studio Reference Guide 43

Choice Group The name of the choice group the model applies to.

Label for Choice The label for the Choice Group

Base Event The Base Event is the choice event used as a base for analysis.

Base Event Label The label for the base event as shown in Decision Center

Positive Outcome events Positive Outcome events are those events that indicate a successful prediction

Attributes

Partitioning attributes Each analytic model consists of a number of sub-models, each corresponding to
a separate combination of values of partitioning attributes.

A decision to make an attribute a partitioning one has to be based on a radical
difference in predicted likelihood depending on the value of the attribute in
question. Attributes that have moderate effect on predicted results should be
treated as regular input, not as partitioning. The Model size is very sensitive to
cardinality of partitioning attributes. Two partitioning attributes with cardinality 10
each would result in a model 25 times larger than the one that would be
produced if each of the partitioning attribute had cardinality 2.

Excluded attributes By default all session and entity attributes are used as model inputs. To prohibit
the model from using some attributes as inputs you can add them to the
Excluded Attributes list. Note to exclude an entity attribute from all models, it is
easier to do by turning off Use for analysis option in the properties of the
attribute itself.

The Learn Location tab and the Temporary Data Storage tab are the same:

Learn location

Learn location By default all models learn at the session close time. Alternatively, you can make
learning happen when individual Informant or Advisor Integration Points are
called. Take into account that it is usually more efficient to store all needed data
in the session and pass it to the models once at the end of the session.

Temporary data storage In business processes that take considerable amount of time a choice outcome
may become known few weeks or even months after the choice is made. Original
values of the entity attributes may not be available at the time of learning of the
choice outcome. It is desirable, however, to provide the learning model with
exactly same values of all input and partitioning attributes as they had at the
moment of selecting the choice.

When Use temporary data storage option is enabled, the model stores values of
all input and partitioning attributes whenever it receives a value of its target
attribute that corresponds to the base event. The model creates one or more
nearly identical database records, one for each session keys included in the Keys
list.

When temporary data storage is enabled, it is possible to provide the model with
a choice outcome without worrying about values of the input attributes. The
values of all input model attributes are retrieved from the previously stored
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record.

Days to Keep Specifies the number of days to keep temporary data stored on the server.

Keys The data stored in temporary data storage is available for retrieval by having ANY
ONE of the keys defined in the data storage tab.

Advanced The Advanced button allows you to choose to show the element in Decision
Center and to change the label of the element. Changing the label of the element
does not change the Object ID.

2.13.3 Additional Model attributes

The Use explicit base option tells the model to expect explicit notifications of decisions (base events) and assume that
it will not receive notifications for one of the decision outcomes.

Choice event models are always defined with an explicit base event, so Use explicit base check box is only displayed
for general purpose models.

The target attribute is the subject of predictions. The model is able to predict likelihoods of different values of the target
attribute. For model performance it is highly recommended to specify all possible values of the target attribute in the
Possible Values field.

2.13.4 About partitioning and aggregation

Each analytic model consists of a number of sub-models, each corresponding to a separate combination of values of
partitioning attributes. A decision to make an attribute a partitioning one has to be based on a radical difference in
predicted likelihood depending on the value of the attribute in question. Attributes that have moderate effect on
predicted results should be treated as regular input, not as partitioning. Model size is very sensitive to cardinality of
partitioning attributes. Two partitioning attributes with cardinality 10 each would result in a model 25 times larger than
the one that would be produced if each of the partitioning attribute had cardinality 2.

By default all session and entity attributes are used as model inputs. To prohibit the model from using some attributes
as inputs you can add them to the Excluded Attributes list. Notice that if you need to exclude an entity attribute from
all models, it is easier to do by turning off Use for Analysis option in the properties of the attribute itself.

One of the partitioning attributes can be marked as aggregated. This results in creation of additional sub-models, which
exclude the aggregated attribute. For example, marking "choice" attribute as aggregated allows the model to be used
to predict a likelihood of positive response to any choice.

2.13.5 Model APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and Id respectively.

Querying the Model

The model can be queried using any of the getChoiceEventLikelihood methods shown below. This will
return the likelihood of a choice being chosen by the model.

public static SDDoubleArray getChoiceEventLikelihoods(GENOffersChoice
choice);
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public static SDDoubleArray getChoiceEventLikelihoods(GENOffers
choiceGroup) ;

public static double getChoiceEventLikelihoods(GENOffersChoice choice,
String eventName);

public static double getChoiceEventLikelihoods(GENOffers choiceGroup,
String eventName);

Recording the choice with the model

For the Choice Event Model, the model method recordEvent is executed when a call to the Choice method
recordEvent is made. Therefore it is not necessary to directly invoke this method on the model. This method
is usually called from within the Integration Point where the choice was extended to the calling application.

For instance, in an Advisor Intgeration Point:

if (choices.size() > 0) {

Choice ch = choices.get(0);

ch.recordEvent("Presented");

session().setOfferExtended(ch.getSDOId());

}

For the Choice Model, the following APIs are available:

public static SDStringArray getChoice()

public static void setChoice(SDStringArray _v)

public static void addToChoice(String _a)

public static void addAllToChoice(SDStringArray _c)

The Informant usually records a choice with the model. For instance, in a case where we are recording the choice of a
call reason code with the Model Reason Analysis:

if (code == 17)

ReasonAnalysis.addToChoice("BalanceInquiry");

else if (code == 18)

ReasonAnalysis.addToChoice("MakePayment");

else if (code == 19)

ReasonAnalysis.addToChoice("RateInquiry");

else

ReasonAnalysis.addToChoice("Other");
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If the choices were not marked mutually exclusive, this call must include a call to getModelData() before
recording the choice:

if (code == 17)

ReasonAnalysis.getModelData().addToChoice("BalanceInquiry");

else if (code == 18)

ReasonAnalysis.getModelData().addToChoice("MakePayment");

else if (code == 19)

ReasonAnalysis.getModelData().addToChoice("RateInquiry");

else

ReasonAnalysis.getModelData().addToChoice("Other");

If you are working with a Choice Array you should send an empty string to the model first:

ReasonAnalysis.getModelData().addToChoice("");

2.14 About Integration Points
Integration Points perform within Siebel RTD from two points of view: data and process.

From the data point of view, Integration Points provide values to Entity attributes. The Integration Point definition
includes a mapping for assigning incoming values to Session or Entity attributes.

From the process point of view, Integration Points are defined to follow a unit as it passes through the different systems
that implement the process. In general it is best to identify the earliest point at which a unit can be identified. At that
point in the process an Informant is called by the enterprise operational systems. The system sends a request to the
Informant and this enables the Inline Service to begin forming the Session and, if desired, pre-fetch information from
some of the data sources.

Next, other points in the process where interesting information or measurements are known are identified and
Informants are defined for them.

Sometimes the Inline Service runs in an observation-only mode, where there are no Advisors but just Informants. This
may be useful to gather information about the process and measure the non-optimized performance. In this case,
Informants record observations with Models so that the models can find correlations and trends in the data.

Advisors are defined for each point in the process where an Inline Intelligence Decision is to be supplied to an
operational system.

An External System and an Order Number are also defined for each Integration Point. These are used to generate the
process map presented in the Decision Center. The System determines the swim-lane and the order the position, from
left to right. The order can be any number, not just integers, thus allowing for introducing new Integration Points without
modifying existing ones.

For information about operational systems accessing Integration Points, see Integration with Siebel RTD.
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2.14.1 About Informants

An Informant publishes reports from the data and analysis gathered by its model. The targets for that analysis are
choices in one or more Choice Groups. Informants contain the logic needed to process and publish to the model.
Entities act to organize data into objects for decision making and analysis.

2.14.2 About Informant Functionality

Informants act in concert with Choice Groups as targets for analysis and an analytical model to perform the analysis. In
general to add an Informant to the Inline Service you do the following:

1. Create an External System to identify which system accesses the Integration Point.

2. Create a Choice Group to represent the targets for your analysis. For instance a Choice Group may
represent the reasons for calls to the service center.

3. Create an Informant that receives the session key information and gathers and processes data based
on the session.

4. Create an analytical model that is the repository for the data and analyzes it.
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Informants have the following characteristics:

Description Description of the Informant

Request

Session Keys One or more session keys used to identify the beginning and end of a session.
Any of the session keys within the message is sufficient for identifying a session,
and hence causing the message to be dispatched to an existing session, if any,
already containing information related to this message.

External System External System Identifies the external system that will be sending the Informant
a Request. Associating the Informant with an external system allows the
Informant to be displayed among other Informants and Advisors in Decision
Center's process map.

Order This number identifies the position of the Informant in the sequence of Integration
Points displayed in Decision Center's process map. An Integration Point with an
Order less than another integration point's order will be displayed before the other
integration point. The Order can be a decimal number; for example, 2.1 will be
displayed before 2.2.

Force Session Close When checked, this causes the Inline Service to automatically terminate the
Informant's session after all of the Informant's Asynchronous Logic has executed.
The same effect can be achieved by placing the following java statement
anywhere in any sub-tab of the Informant's Logic tab:
session().close();

Adding a session key

On the Request tab use the Select button to select a session key for the Integration Point. This is one of the values
that the operational system will supply to the Integration Point.

Identifying the External System and Order

On the Request tab use the drop down menu to choose the External System that accesses the Integration Point. This
menu is populated by creating External System identifiers using the External System element.

The order in which the Integration Points are accessed is represented by Order. This number and the External
System determine how the end-to-end process is displayed in Decision Center.

Adding Request Data

On the Request tab use the Add button to add request Data. Assignments are the values that the operational system
will supply to the Integration Point. Assignments have the following characteristics:

Incoming Parameter The name of the field in the Request sent to the Informant whose value will be
copied from the Request to the Session attribute. This name does not have to be
the same as the Session attribute, however it generally is named the same.

After the Session key is created the assignment of incoming parameters to
Session key attributes is made.

Type This is the data type of the Session attribute into which the incoming argument
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will be copied. The valid types are: integer, string, date or double.

Note: If the type of the Request field and the Session key attribute do not match,
you should use a transform method.

Array Marked if the type is a collection.

Session Attribute The attribute of the Session that the incoming parameter of a request will be
mapped to.

2.14.3 Adding Imported Java classes and Changing Decision Center Display

To add imported Java classes to your Inline Service, use the Advanced button adjacent to description. You may also
change the display label for Decision Center and choose whether the element is displayed in the Decision Center
Navigator. Changing the display label does not affect the Object ID.

2.14.4 Informant APIs

public String getSDOLabel();

public String getSDOId();

Returns the Object label and Id respectively.

2.14.5 Informant Logic

Logic

This script runs after any Request Data declared in Request Data are executed. If the primary purpose of the Informant
is to transfer data from the operational system Request fields to the session key and Request Data, Logic may be
unnecessary as this happens automatically according to declarations in the Request Data tab.

Logic in Informants is typically used for tracing message reception in the log file, or for pre-populating entities whose
keys are supplied by the Informant's message, in order to avoid having to do this later in an Advisor, where response
time might be more important. Logic is executed directly following the Request Data.

Logic in the Informant can also be used to record choices with a Choice Model. See the Choice Model APIs for
methods to call.

Asynchronous Logic

This script runs after the script defined in Logic, described above. Any additional processing that needs to be done can
be placed in this area. The order of execution of Asynchronous Logic is not guaranteed.

2.14.6 About Models and Informants

Sometimes the Inline Service runs in an observation-only mode, where there are no Advisors but just Informants. This
may be useful to gather information about the process and measure the non-optimized performance. In this case the
logic of the Informant generally uses methods of the Choice to record events to the Model.

Accessing Request data from the Informant

Request data from an Informant is accessed one of several ways. If the incoming parameter is mapped to a session
attribute, there is a get method for the parameter.

request.get$()
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where $ is the parameter name with the first letter capitalized.

If the attribute is not mapped, there are methods to achieve the same results using the field name of the parameter.

String request.getStringValue(fieldName)

SDStringArray request.getStringArrayValue(fieldName)

boolean request.isArgPresent(fieldName)

2.14.7 About Advisors

Advisors are defined for each point in the process where an Inline Intelligence Decision is desired. Typically each
Advisor will make use of two specific Decision objects, one for the optimized Decision and one for the Control Group.

The Control Group decision should be as close to the existing business process as possible, so that the Optimized
Decision has a basis for comparison.

In addition to the Decisions, default Choices can be defined for the Advisor. These Choices are used when the
computation in the server can not be completed in time or if the client loses communication with the server.

Choice Groups and Choices have rules. The rules determine the situations in which the Choice or Choice Group and
all its descendants are available to be sent as results of the decision back to the caller of the Advisor. These rules can
refer to Session or Entity values or to Choice settings. For example, a choice may be available only for customers in
certain groups, where the current customer group is an Entity attribute and the groups is a choice attribute.

2.14.8 About the Advisor Decisioning Process

Advisors act in concert with Choice Groups as targets for a Decision. Scoring, in the form of functions, scoring rules,
analytical models or constants, of the Choices helps to decide which Choice is appropriate. The Decision then weights
the scores according to Performance Goals that the organization has defined. The resulting highest scored Choice is
the Decision that is given to the Advisor as a response. For more about the Decisioning Process, see 2.11 About the
Decision Process.

Advisors have the following characteristics:

Description Description of the Advisor

Request

Session Keys One or more session keys used to identify the beginning and end of a session.
Any of the session keys within the message is sufficient for identifying a session,
and hence causing the message to be dispatched to an existing session, if any,
already containing information related to this message.

When the Advisor is called, the Session key creation is the first thing executed.

External System External System identifies the external system that will be sending the Advisor a
Request. Associating the Advisor with an external system allows the Advisor to
be displayed among other Informants and Advisors in Decision Center's process
map.

Order This number identifies the position of the Advisor in the sequence of integration
points displayed in Decision Center's process map. An integration point with an
Order less than another integration point's order will be displayed before the other
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integration point. The Order can be a decimal number; for example, 2.1 will be
displayed before 2.2.

Force Session Close When checked, this causes the Inline Service to automatically terminate the
Advisor’s session after all of the Advisor’s Asynchronous Logic has executed.
The same effect can be achieved by placing the following java statement
anywhere in any sub-tab of the Advisor's Logic tab:
session().close();

2.14.9 Adding Imported Java classes and Changing Decision Center Display

To add imported Java classes to your Inline Service, use the Advanced button adjacent to description. You may also
change the display label for Decision Center and choose whether the element is displayed in the Decision Center
Navigator. Changing the display label does not affect the Object ID.

2.14.10 Adding a session key

On the Request tab use the Select button to select a session key for the Integration Point. This is one of the values
that the operational system will supply to the Integration Point

2.14.11 Identifying the External System and Order

On the Request tab use the drop down menu to choose the External System that accesses the Integration Point. This
menu is populated by creating External System identifiers using the External System element.

The order in which the Integration Points are accessed is represented by Order. This number and the External
System determine how the end-to-end process is displayed in Decision Center.

2.14.12 Adding Request Data

On the Request tab use the Add button to add Request Data. Request Data are the values that the operational
system will supply to the Integration Point. Request Data have the following characteristics:

Request Data

Incoming
Parameter

The name of the field in the Request sent to the Advisor whose value will be copied from the
Request to the Session attribute. This name does not have to be the same as the Session attribute,
however it generally is named the same.

After the Session key is created the assignment of incoming parameters to Session attributes is
made.

Type This is the data type of the Session attribute into which the incoming argument will be copied. The
valid types are: integer, string, date or double.

Note: If the type of the Request field and the Session attribute do not match, you should use a
transform method.

Array Marked if the type is a collection.

Session
Attribute

The attribute of the Session that the incoming parameter of a request will be mapped to.
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2.14.13 Adding Response Data

On the Response tab use the Add button to add Response Data. Response Data are the values that the operational
system will send back to the Integration Point after a Request is invoked. Response Data have the following
characteristics:

Response The Response contains an array of selected Choice objects, with each choice containing a
collection of named attribute values. The choice selection process is governed by one of two
Decision objects referenced by the Advisor. One Decision is given to the calling application

Decision to Use The name of the Decision object to use for normal sessions, as opposed to control-group
sessions. This Decision becomes the Advisor’s Response to the calling system.

Control Group
Decision to Use

Control Group Decision is used for only a small percentage of sessions as a way to assess the
effectiveness of the other Decision by providing a baseline. The percentage of sessions that
use the control-group decision is specified in the Application element of the Inline Service. The
Control Group Decision should be designed to select choices using "business-as-usual" logic,
meaning whatever rules the enterprise previously used before introducing the Inline Service.
Reports are available through the Decision Center console comparing the business
effectiveness of the Advisor's normal Decision object compared to its Control Group Decision.

Parameters Input parameter defined by the decision. The Name and Type columns are descriptive only,
surfaced here from the Decision object.

Default number of
choices returned

Default number of choices returned by the decision. This is the number of choices defined by
the Decision.

Override default
with

The Advisor can override or accept the number specified by the referenced Decision. This area
specifies the maximum number of qualified choices to be included in the Advisor's response.

Default Choices A list of Choices that are returned to the calling client application whenever it tries to invoke this
Advisor and the Advisor is not able to deliver its response within the server's guaranteed
response time.

Note that default Choices do not have to be specified for each Advisor. The Inline Service may
also declare default choices, which will be used for Advisors that don't declare their own. Also
note that the default choice configuration is propagated to the client application and stored in
the local file system by the Smart Client component. Hence it is subsequently available to client
applications that cannot connect to the server.

2.14.14 Logic in Advisors

Logic

The script that runs after any Request Data declared in the Request Data tab are executed, and before the response is
sent back to the client.

Advisor logic is generally no needed. You may wan to use it for preprocessing of data coming in with the request, or for
debugging purposes.

Asynchronous Logic
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This script runs after the response has been handed off to the server-side mechanism which sends it back to the client.
Depending on the type of endpoint used by the client, the client may be able to start processing the result before this
script finishes, thus improving the effective response time by increasing parallelism.

2.14.15 Accessing Request data from the Advisor

Request data from an Advisor is accessed one of several ways. If the incoming parameter is mapped to a session
attribute, there is a get method for the parameter.

request.get$()

where $ is the parameter name with the first letter capitalized.

If the attribute is not mapped, there are several methods to achieve the same results.

String request.getStringValue(fieldName)

SDStringArray request.getStringArrayValue(fieldName)

boolean request.isArgPresent(fieldName)

2.15 About External Systems
External Systems are only identified within Studio. The External System represents the operational systems within the
enterprise that integrate to the Inline Service. The External System is not accessible via API. The External System is
used by an Integration Point to identify which external system will access that Integration Point. External Systems are
used for display on the Integration Map in Decision Center.

External Systems have the following characteristics:

Description Description of the system

Display Label Allows you to change the Display Label. This does not affect the Object ID.

2.16 About the Categories Object
Categories are available to organize choices. All choices of the same category appear together in Decision Center. No
classes are generated for categories. They are only used by Decision Center for grouping and organizing choices.

Categories have the following characteristics:

Name Name of the category as entered in Studio

Description Description of the category as entered in Studio

Display Label Allows you to change the Display Label. This does not affect the Object ID.

2.17 About Functions
Functions can be used for calculation or for other processing that you would like to make reusable. Functions are
defined using Studio. Functions are defined with the following characteristics:
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Description Description of the function

Return value Specifies if the function returns a value.

Data Type Type of the returned value.

Array Mark if the return type is an array.

Call Template The definition of how the function will be called. Using {0}, {1}, and so on as
arguments, and phrasing to describe the function, define the template for call. It
is important to use good phrasing as this is what will be shown when using the
function. For instance, a call template for multiply is - {0} multiplied by {1}.

Parameters Named parameters that will be used in the logic of the function. This number
must match the number of arguments in the call template. For instance, multiply
has the following parameters: a, type Double; b, type Double

Logic Java code for the function. The code for multiply is:

return a * b;

2.17.1 Adding Imported Java classes and Changing Decision Center Display

To add imported Java classes to your Inline Service, use the Advanced button adjacent to description. You may also
change the display label for Decision Center and choose whether the element is displayed in the Decision Center
Navigator. Changing the display label does not affect the Object ID.

Functions are called from other elements using the call template. For instance, if you wanted to use the 'multiply'
function described above, you would choose the function from the Edit Value dialog. The call template '{0} multiplied
by {1}' provides the editor with the position and number of arguments.

2.18 Statistic Collector
Statistic collectors manage collection and life cycle of Inline Service event statistics.. A Choice Event Statistics
Collector is created for each Inline Service. Choice Event Statistics Collectors automatically collect statistics for the
events defined by your Inline Service. Statistics Collector has the following properties:

Description The description of the Statistics Collector.

Collect Statistics On Statistics can be collected either for each object, e.g. choice or choice group,
individually, or aggregated for all objects of the same type.

Aggregation Either record individual events or record aggregated data. Care should be used in
recording individual events as high transactional systems may suffer from
performance issues.

Aggregation Interval Amount of time in seconds to aggregate data before recording it.

Expiration Either Keep forever or Purge old statistics. Care should be used in choosing
Keep forever as data size can be an issue.

Keep in database for Amount of time in days that data is kept before purging.

All parameters are configurable through the Studio editor. Choice Event Statistics are displayed as a report in Decision
Center.
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2.18.1 Creating a custom Statistics Collector

Create a Statistics Collector to record additional statistics about objects or classes. For instance, you can create a
Statistics Collector to record statistics about Choices. In this example

To use the customer Statistics Collector, create a Statistics Collector using Studio. Configure the parameters as
described above.

In code in your Inline Service (for instance in an Informant or via a Function Call) create a Statistics Collector Factory,
passing in the Collector Name (String) or the statistic type (String):

StatisticCollectorFactory factory = Application.getCollectorFactory(<stat
collector name | statistic type>);

Using the factory, create a collector, passing in the event name you want to collect statistics on (String) or the statistic
name (String):

StatCollectorInterface collector = factory.getCollector(<event name |
statistic name> );

The event name or statistic name is an arbitrary string that represents what you want to collect.

Then, finally, using the collector, record the event passing in the object_type (String), object_id (String), event value
(double), and extra_data (string) to record:

Collector.recordEvent(<object_type>, <object_id>, event value, extra
data);

The object_type must be a valid Object type, such as Choice, Choice Group, Entity, etc. The object_id is the internal
name of the object.

2.19 About Decision Center perspectives
Decision Center perspectives can be assigned for use by different groups of users. On installation, two user groups or
responsibilities are added: 'SDDecisionCenterUsers' and 'SDDecisionCenterEditors'.

These groups are used to define permissions on perspectives for Decision Center. Add users or groups who have
read-only permission to 'SDDecisionCenterUsers'; add users who have edit permission to 'SDDecisionCenterEditors'
See Installation and Administration of Siebel RTD for information on defining these groups and adding users.

By default, three perspectives are installed: 'Explore', 'Define' and 'At a Glance' Your system administrator may have
added additional perspectives.

In the Inline Service Navigator, select a perspective and right-click to get Properties. Use the Add and Remove
buttons to add or remove the groups 'SDDecisionCenterUsers' and 'SDDecisionCenterEditors'.

Select the group you want to assign permission to use the perspective to, and check Use perspective under
Permissions. Click OK to finish.
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Section 3: Siebel RTD General APIs
3.1 com.sigmadynmics.util

Class Null
A utility class called Null that tests for Null.

isNull

public static boolean isNull(String val)

Parameters:

val – The String value to be tested for null

Returns:

true or false depending on whether the value is null or not.

isNull

public static boolean isNull(boolean val)

Parameters:

val – The boolean value to be tested for null

Returns:

true or false depending on whether the value is null or not.

isNull

public static boolean isNull(long val)

Parameters:

val – The long value to be tested for null

Returns:

true or false depending on whether the value is null or not.

isNull

public static boolean isNull(float val)

Parameters:

val – The float value to be tested for null
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Returns:

true or false depending on whether the value is null or not.

isNull

public static boolean isNull(int val)

Parameters:

val – The int value to be tested for null

Returns:

true or false depending on whether the value is null or not.

Object

3.2 com.sigmadynamics.support
Class SDOBase

Methods for logging are defined in the SDO base class. These methods are available for use throughout any Inline
Service.

Three levels of logging are available: Info, Warning and Debug. By default the Info level is enabled and available in the
Inline Service and goes to the Error Log. To enable the other levels, use the JMX Console. For more about using the
JMX console, see Installation and Administration of Siebel RTD.

logDebug

public static void logDebug(String msg)

Logs a String message at the debugging level.

Parameters:

msg – the String value to log.

logDebug

public static void logDebug(String msg, Object[] args)

Logs a String message and an array of Objects at the debugging level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.
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logDebug

public static void logDebug(String msg, Throwable t)

Logs a String message and an exception at the debugging level.

Parameters:

msg – the String value to log.

t – the exception to be logged.

logDebug

public static void logDebug(String msg, Object[] args, Throwable t)

Logs a String message, an array of Objects and an exception at the debugging level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.

t - the exception to be logged.

logInfo

public static void logInfo (String msg)

Logs a String message at the informational level.

Parameters:

msg – the String value to log.

logInfo

public static void logInfo(String msg, Object[] args)

Logs a String message and an array of Objects at the informational level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.
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logInfo

public static void logInfo(String msg, Throwable t)

Logs a String message and an exception at the informational level.

Parameters:

msg – the String value to log.

t – the exception to be logged.

logInfo

public static void logInfo(String msg, Object[] args, Throwable t)

Logs a String message , an array of Objects and an excepton at the informational level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.

t - the exception to be logged.

logWarning

public static void logWarning(String msg)

Logs a String message at the warning level.

Parameters:

msg – the String value to log.

logWarning

public static void logWarning(String msg, Object[] args)

Logs a String message and an array of Objects at the warning level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.
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logWarning

public static void logWarning(String msg, Throwable t)

Logs a String message and an exception at the warning level.

Parameters:

msg – the String value to log.

t – the exception to be logged.

logWarning

public static void logDebug(String msg, Object[] args, Throwable t)

Logs a String message, an array of Objects and an exception at the warning level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.

t - the exception to be logged.

logError

public static void logError(String msg)

Logs a String message at the error level.

Parameters:

msg – the String value to log.

logError

public static void logError(String msg, Object[] args)

Logs a String message and an array of Objects at the warning level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.
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logError

public static void logError(String msg, Throwable t)

Logs a String message and an exception at the error level.

Parameters:

msg – the String value to log.

t – the exception to be logged.

logError

public static void logError (String msg, Object[] args, Throwable t)

Logs a String message, an array of Objects and an exception at the error level.

Parameters:

msg – the String value to log.

args – the Object array to log. Object arrays are first converted to string values using toString.

t - the exception to be logged.

logError

public static void logError (Throwable t)

Logs an exception at the error level.

Parameters:

t - the exception to be logged.

3.3 com.sigmadynamics.util
Class StringUtil

The StringUtil class contains methods that return various types in the form of a readable string. This is useful for
debugging.

toString

public static String toString(int[] array)

Converts an array to a string.
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Parameters:

array – the integer array to be converted

Returns:

The string is returned in the form [elem1, elem2, ...]

toString

public static String toString(long[] array)

Converts an array to a string.

Parameters:

array – the array of type long to be converted

Returns:

The string is returned in the form [elem1, elem2, ...]

toString

public static String toString(String[] array)

Converts an array to a string.

Parameters:

array – the array of type String to be converted

Returns:

The string is returned in the form [elem1, elem2, ...]

toString

public static String toString(Object[] array)

Converts an array to a string.

Parameters:

array – the array of type Object to be converted

Returns:

The string is returned in the form [elem1, elem2, ...]
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toString

public static String toString(double[] array, int precision)

Converts an array to a string.

Parameters:

array – the array of type double to be converted

precision – the number of precision digits to preserve

Returns:

The string is returned in the form [elem1, elem2, ...]. The values are returned as a string with the specified precision
number of mantissa digits to preserve.

toString

public static String toString(double[] array)

Converts an array to a string.

Parameters:

array – the array of type double to be converted

Returns:

The string is returned in the form [elem1, elem2, ...]. The values are returned as a string with four mantissa digits
preserved.

3.4 com.sigmadynamics.util
Class DateUtil

The DateUtil class contains methods that return a date formatted in various ways.

getCalendar

public static Calendar getCalendar(long datetime)

Converts date and time in milliseconds since January 1, 1970 UTC to Calendar object.

Parameters:

datetime - Date and time in milliseconds since January 1, 1970 UTC.

Returns:

A Calendar object representing the date.
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See Also: Calendar

formatDate

public static String formatDate(long date)

Converts date in milliseconds since January 1, 1970 UTC to a string representation.

Parameters:

date - Date in milliseconds since January 1, 1970 UTC.

Returns:

The date is short string form, e.g. "4/21/03" in the US locale.

formatTime

public static String formatTime(long time)

Converts time in milliseconds since January 1, 1970 UTC to a string representation.

Parameters:

time - Time in milliseconds since January 1, 1970 UTC.

Returns:

The time value is short string form, e.g. "8:35 pm" in the US locale.

formatDateTime

public static String formatDateTime(long datetime)

Converts date and time in milliseconds since January 1, 1970 UTC to a string representation.

Parameters:

datetime - Date and time in milliseconds since January 1, 1970 UTC.

Returns:

The date and time is short string form, e.g. "4/21/03 8:35 pm" in the US locale.

format

public static String format(long datetime, DateFormat format)

Formats date and time in milliseconds since January 1, 1970 UTC according to a supplied format specification.

Parameters:
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datetime - Date and time in milliseconds since January 1, 1970 UTC.

format - The format specification.

Returns: The formatted date/time string.

See Also: DateFormat

3.5 com.sigmadynamics.util
Class SDArray classes

Various array classes are provided. The base class for these is SDArray.

public abstract class SDArray

extends Object

implements Serializable

This abstract class serves as a base for specialized SDArrayType classes.

Constant Field Values

protected static final int ALLOC_UNIT

protected static final int DEFAULT_INITIAL_SIZE

protected int size

Constructor Detail

SDArray

public SDArray()

Default constructor.

size

public final int size()Returns the number of elements in the array.

Returns:

the number of elements.

isEmpty

public final boolean isEmpty()

Returns true if the array does not contain any elements, or false otherwise.

Returns:
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true or false depending on whether the array is empty or not.

capacity

public abstract int capacity()

Returns:

buffer capacity.

setSize

public abstract void setSize(int size)

Adds or deletes elements at the end of the array.

Parameters:

size - new number or elements.

clear

public void clear()

Deletes all elements from the array.

trimToSize

public abstract void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

ensureCapacity

protected abstract void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.

Parameters:

capacity - number of elements to accommodate.

3.6 com.sigmadynamics.util
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Class SDBooleanArray
A type safe implementation of a resizable array containing elements of type boolean.

public class SDBooleanArray

extends SDArray

Field Detail

buf

protected boolean[] buf

Constructor Detail

SDBooleanArray

public SDBooleanArray()

Constructs an empty array.

SDBooleanArray

public SDBooleanArray(int capacity)

Constructs an empty array with the specified initial capacity.

Parameters:

capacity - the initial capacity of the array.

capacity

public int capacity()

Returns:

buffer capacity.

Specified by:

capacity in class SDArray

Returns:
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buffer capacity.

get

public boolean get(int index)

Returns:

the element at the specified position in this array.

Parameters:

index - index of the element to return.

set

public void set(int index, boolean val)

Replaces the element at the specified position in this array with the specified element.

Parameters:

index - index of the element to replace.

add

public void add(boolean element)

Appends the specified element to the end of this array.

Parameters:

element - element to be appended to this array.

addAll

public void addAll(SDBooleanArray array)

Appends all of the elements in the specified array to the end of this array.

Parameters:

array - array containing elements to be appended to this array.

fill



Siebel Decision Studio Reference Guide 69

public void fill(boolean element)

Replaces all elements of this array with the same value.

Parameters:

element - element that replaces all elements of this array.

fill

public void fill(int fromIndex, int toIndex, boolean element)

Replaces a group of consecutive elements of this array with the same value. The group of elements to be replaced
consists of elements whose index is between fromIndex, inclusive, and toIndex, exclusive.

Parameters:

fromIndex - index of the first element to be replaced.

toIndex - index after the last element to be replaced.

element - element that replaces the elements from fromIndex to toIndex.

contains

public boolean contains(boolean element)

Returns true if this array contains the specified element.

Parameters:

element - element whose presence in this array is to be tested.

Returns:

true if the specified element is present; false otherwise.

containsAll

public boolean containsAll(SDBooleanArray elements)

Returns true if this array contains all elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:
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true if all specified elements is present in this array; false otherwise.

containsAny

public boolean containsAny(SDBooleanArray elements)

Returns true if this array contains any one of the elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if any specified elements are present in this array; false otherwise.

sort

public void sort()

Sorts the array in ascending order.

equals

public boolean equals(Object anObject)

Element by element comparison.

Parameters:

anObject - an object to compare this array with.

Returns:

true if the arrays are equal, false otherwise.

toArray

public boolean[] toArray()

Returns an array of boolean containing all elements of this one.

Returns:

an array of boolean containing all elements of this one.
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toArray

public void toArray(boolean[] array)

Copies elements to a given array. If the supplied array is shorter than the number of elements in this one, only the
elements that fit the supplied array are copied. If the supplied array is longer than the number of elements in this one,
the rear part of the supplied array remains unchanged.

Parameters:

array - the array to which the elements of this one are to be copied.

Throws:

ArrayStoreException - if the runtime type of the supplied array is not a supertype of the runtime type of every element
in this one.

setSize

public void setSize(int size)

Adds or deletes elements at the end of the array.

Specified by:

setSize in class SDArray

Parameters:

size - new number or elements.

Throws:

IllegalArgumentException - if size < 0.

trimToSize

public void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

Specified by:

trimToSize in class SDArray

toString

public String toString()
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Returns a string representation of this array. The string representation consists of elements of the array enclosed in
square brackets ("[]"). Adjacent elements are separated by the characters ", " (comma and space). Elements are
converted to strings by String.valueOf(boolean).

Returns:

a string representation of this array.

indexOf

public static int indexOf(boolean element, boolean[] array)

Returns the index in an array of the first occurrence of the specified element, or -1 if the array does not contain such
element. This method uses linear search.

ensureCapacity

protected void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.

Specified by:

ensureCapacity in class SDArray

Parameters:

capacity - number of elements to accommodate.

3.7 com.sigmadynamics.util
Class SDDoubleArray

Type safe implementation of resizable array containing elements of type double.

public class SDDoubleArray

extends SDArray

Field Detail

buf

protected double[] buf

Constructor Detail
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SDDoubleArray

public SDDoubleArray()

Constructs an empty array.

SDDoubleArray

public SDDoubleArray(int capacity)

Constructs an empty array with the specified initial capacity.

Parameters:

capacity - the initial capacity of the array.

capacity

public int capacity()

Returns buffer capacity.

Specified by:

capacity in class SDArray

Returns:

buffer capacity.

get

public double get(int index)

Returns the element at the specified position in this array.

Parameters:

index - index of the element to return.

Returns:

The element at the specified position in this array.

set

public void set(int index, double val)
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Replaces the element at the specified position in this array with the specified element.

Parameters:

index - index of the element to replace.

add

public void add(double element)

Appends the specified element to the end of this array.

Parameters:

element - element to be appended to this array.

addAll

public void addAll(SDDoubleArray array)

Appends all of the elements in the specified array to the end of this array.

Parameters:

array - array containing elements to be appended to this array.

fill

public void fill(double element)

Replaces all elements of this array with the same value.

Parameters:

element - element that replaces all elements of this array.

fill

public void fill(int fromIndex, int toIndex, double element)

Replaces a group of consecutive elements of this array with the same value. The group of elements to be replaced
consists of elements whose index is between fromIndex, inclusive, and toIndex, exclusive.

Parameters:

fromIndex - index of the first element to be replaced.



Siebel Decision Studio Reference Guide 75

toIndex - index after the last element to be replaced.

element - element that replaces the elements from fromIndex to toIndex.

contains

public boolean contains(double element)

Returns true if this array contains the specified element.

Parameters:

element - element whose presence in this array is to be tested.

Returns:

true if the specified element is present; false otherwise.

containsAll

public boolean containsAll(SDDoubleArray elements)

Returns true if this array contains all elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if all specified elements is present in this array; false otherwise.

containsAny

public boolean containsAny(SDDoubleArray elements)

Returns true if this array contains any one of the elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if any specified elements are present in this array; false otherwise.

sort
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public void sort()

Sorts the array in ascending order.

equals

public boolean equals(Object anObject)

Element by element comparison.

Parameters:

anObject - an object to compare this array with.

Returns:

true if the arrays are equal, false otherwise.

toArray

public double[] toArray()

Returns an array of double containing all elements of this one.

Returns:

an array of double containing all elements of this one.

toArray

public void toArray(double[] array)

Copies elements to a given array. If the supplied array is shorter than the number of elements in this one, only the
elements that fit the supplied array are copied. If the supplied array is longer than the number of elements in this one,
the rear part of the supplied array remains unchanged.

Parameters:

array - the array to which the elements of this one are to be copied.

Throws:

ArrayStoreException - if the runtime type of the supplied array is not a supertype of the runtime type of every element
in this one.

setSize
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public void setSize(int size)

Adds or deletes elements at the end of the array.

Specified by:

setSize in class SDArray

Parameters:

size - new number or elements.

Throws:

IllegalArgumentException - if size < 0.

trimToSize

public void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

Specified by:

trimToSize in class SDArray

toString

public String toString()

Returns a string representation of this array. The string representation consists of elements of the array enclosed in
square brackets ("[]"). Adjacent elements are separated by the characters ", " (comma and space). Elements are
converted to strings by String.valueOf(double).

Returns:

a string representation of this array.

indexOf

public static int indexOf(double element, double[] array)

Returns the index in an array of the first occurrence of the specified element, or -1 if the array does not contain such
element. This method uses linear search.

ensureCapacity
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protected void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.

Specified by:

ensureCapacity in class SDArray

Parameters:

capacity - number of elements to accommodate.

increment

public double increment(int index, double amount)

Increments an element by a given amount.

Parameters:

index - element index.

amount - a value to add to the element.

Returns:

the incremented value.

decrement

public double decrement(int index, double amount)

Decrements an element by a given amount.

Parameters:

index - element index.

amount - a value to add to the element.

Returns:

the incremented value.

3.8 com.sigmadynamics.util
Class SDIntArray

Type safe implementation of resizable array containing elements of type integer.
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public class SDIntArray

extends SDArray

Field Detail

buf

protected double[] buf

Constructor Detail

SDIntArray

public SDIntArray ()

Constructs an empty array.

SDIntArray

public SDIntArray (int capacity)

Constructs an empty array with the specified initial capacity.

Parameters:

capacity - the initial capacity of the array.

SDIntArray

public SDIntArray (int[] elements)

This constructor is not a part of the public API and should not be used by Inline Service code.

capacity

public int capacity()

Returns buffer capacity.

Specified by:

capacity in class SDArray
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Returns:

buffer capacity.

get

public double get(int index)

Returns the element at the specified position in this array.

Parameters:

index - index of the element to return.

Returns:

The element at the specified position in this array.

set

public void set(int index, int val)

Replaces the element at the specified position in this array with the specified element.

Parameters:

index - index of the element to replace.

val - value.

add

public void add(int element)

Appends the specified element to the end of this array.

Parameters:

element - element to be appended to this array.

addAll

public void addAll(SDIntArray array)

Appends all of the elements in the specified array to the end of this array.

Parameters:
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array - array containing elements to be appended to this array.

fill

public void fill(int element)

Replaces all elements of this array with the same value.

Parameters:

element - element that replaces all elements of this array.

fill

public void fill(int fromIndex, int toIndex, int element)

Replaces a group of consecutive elements of this array with the same value. The group of elements to be replaced
consists of elements whose index is between fromIndex, inclusive, and toIndex, exclusive.

Parameters:

fromIndex - index of the first element to be replaced.

toIndex - index after the last element to be replaced.

element - element that replaces the elements from fromIndex to toIndex.

contains

public boolean contains(int element)

Returns true if this array contains the specified element.

Parameters:

element - element whose presence in this array is to be tested.

Returns:

true if the specified element is present; false otherwise.

containsAll

public boolean containsAll(SDIntArray elements)

Returns true if this array contains all elements of the specified array.
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Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if all specified elements is present in this array; false otherwise.

containsAny

public boolean containsAny(SDIntArray elements)

Returns true if this array contains any one of the elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if any specified elements are present in this array; false otherwise.

sort

public void sort()

Sorts the array in ascending order.

equals

public boolean equals(Object anObject)

Element by element comparison.

Parameters:

anObject - an object to compare this array with.

Returns:

true if the arrays are equal, false otherwise.

toArray

public int[] toArray()

Returns an array of double containing all elements of this one.
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Returns:

an array of double containing all elements of this one.

toArray

public void toArray(int[] array)

Copies elements to a given array. If the supplied array is shorter than the number of elements in this one, only the
elements that fit the supplied array are copied. If the supplied array is longer than the number of elements in this one,
the rear part of the supplied array remains unchanged.

Parameters:

array - the array to which the elements of this one are to be copied.

Throws:

ArrayStoreException - if the runtime type of the supplied array is not a supertype of the runtime type of every element
in this one.

setSize

public void setSize(int size)

Adds or deletes elements at the end of the array.

Specified by:

setSize in class SDArray

Parameters:

size - new number or elements.

Throws:

IllegalArgumentException - if size < 0.

trimToSize

public void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

Specified by:

trimToSize in class SDArray
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toString

public String toString()

Returns a string representation of this array. The string representation consists of elements of the array enclosed in
square brackets ("[]"). Adjacent elements are separated by the characters ", " (comma and space). Elements are
converted to strings by String.valueOf(int).

Returns:

a string representation of this array.

indexOf

public static int indexOf(int element, int[] array)

Returns the index in an array of the first occurrence of the specified element, or -1 if the array does not contain such
element. This method uses linear search.

ensureCapacity

protected void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.

Specified by:

ensureCapacity in class SDArray

Parameters:

capacity - number of elements to accommodate.

increment

public double increment(int index, int amount)

Increments an element by a given amount.

Parameters:

index - element index.

amount - a value to add to the element.

Returns:
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the incremented value.

decrement

public double decrement(int index, int amount)

Decrements an element by a given amount.

Parameters:

index - element index.

amount - a value to add to the element.

Returns:

the incremented value.

3.9 com.sigmadynamics.util
Class SDLongArray

Type safe implementation of resizable array containing elements of type long.

public class SDLongArray

extends SDArray

Field Detail

buf

protected double[] buf

Constructor Detail

SDLongArray

public SDLongArray ()

Constructs an empty array.

SDLongArray

public SDLongArray (int capacity)

Constructs an empty array with the specified initial capacity.
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Parameters:

capacity - the initial capacity of the array.

SDLongArray

public SDLongArray (int[] elements)

This constructor is not a part of public API and should not be used by Inline Service code.

capacity

public int capacity()

Returns buffer capacity.

Specified by:

capacity in class SDArray

Returns:

buffer capacity.

get

public double get(int index)

Returns the element at the specified position in this array.

Parameters:

index - index of the element to return.

Returns:

The element at the specified position in this array.

set

public void set(int index, long val)

Replaces the element at the specified position in this array with the specified element.

Parameters:

index - index of the element to replace.
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val - value.

add

public void add(long element)

Appends the specified element to the end of this array.

Parameters:

element - element to be appended to this array.

addAll

public void addAll(SDLongArray array)

Appends all of the elements in the specified array to the end of this array.

Parameters:

array - array containing elements to be appended to this array.

fill

public void fill(long element)

Replaces all elements of this array with the same value.

Parameters:

element - element that replaces all elements of this array.

fill

public void fill(int fromIndex, int toIndex, long element)

Replaces a group of consecutive elements of this array with the same value. The group of elements to be replaced
consists of elements whose index is between fromIndex, inclusive, and toIndex, exclusive.

Parameters:

fromIndex - index of the first element to be replaced.

toIndex - index after the last element to be replaced.

element - element that replaces the elements from fromIndex to toIndex.
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contains

public boolean contains(long element)

Returns true if this array contains the specified element.

Parameters:

element - element whose presence in this array is to be tested.

Returns:

true if the specified element is present; false otherwise.

containsAll

public boolean containsAll(SDLongArray elements)

Returns true if this array contains all elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if all specified elements is present in this array; false otherwise.

containsAny

public boolean containsAny(SDLongArray elements)

Returns true if this array contains any one of the elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if any specified elements are present in this array; false otherwise.

sort

public void sort()

Sorts the array in ascending order.
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equals

public boolean equals(Object anObject)

Element by element comparison.

Parameters:

anObject - an object to compare this array with.

Returns:

true if the arrays are equal, false otherwise.

toArray

public long[] toArray()

Returns an array of long containing all elements of this one.

Returns:

an array of double containing all elements of this one.

toArray

public void toArray(long[] array)

Copies elements to a given array. If the supplied array is shorter than the number of elements in this one, only the
elements that fit the supplied array are copied. If the supplied array is longer than the number of elements in this one,
the rear part of the supplied array remains unchanged.

Parameters:

array - the array to which the elements of this one are to be copied.

Throws:

ArrayStoreException - if the runtime type of the supplied array is not a supertype of the runtime type of every element
in this one.

setSize

public void setSize(int size)

Adds or deletes elements at the end of the array.
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Specified by:

setSize in class SDArray

Parameters:

size - new number or elements.

Throws:

IllegalArgumentException - if size < 0.

trimToSize

public void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

Specified by:

trimToSize in class SDArray

toString

public String toString()

Returns a string representation of this array. The string representation consists of elements of the array enclosed in
square brackets ("[]"). Adjacent elements are separated by the characters ", " (comma and space). Elements are
converted to strings by String.valueOf(long).

Returns:

a string representation of this array.

indexOf

public static int indexOf(long element, long[] array)

Returns the index in an array of the first occurrence of the specified element, or -1 if the array does not contain such
element. This method uses linear search.

ensureCapacity

protected void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.
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Specified by:

ensureCapacity in class SDArray

Parameters:

capacity - number of elements to accommodate.

3.10 com.sigmadynamics.util
Class SDStringArray

Type safe implementation of resizable array containing elements of type String.

public class SDStringArray

extends SDArray

Field Detail

buf

protected double[] buf

Constructor Detail

SDStringArray

public SDStringArray ()

Constructs an empty array.

SDStringArray

public SDStringArray (int capacity)

Constructs an empty array with the specified initial capacity.

Parameters:

capacity - the initial capacity of the array.

SDLongArray

public SDLongArray (int[] elements)

This constructor is not a part of public API and should not be used by Inline Service code.
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capacity

public int capacity()

Returns buffer capacity.

Specified by:

capacity in class SDArray

Returns:

buffer capacity.

get

public double get(int index)

Returns the element at the specified position in this array.

Parameters:

index - index of the element to return.

Returns:

The element at the specified position in this array.

set

public void set(int index, String val)

Replaces the element at the specified position in this array with the specified element.

Parameters:

index - index of the element to replace.

val - value.

add

public void add(String element)

Appends the specified element to the end of this array.

Parameters:
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element - element to be appended to this array.

addAll

public void addAll(SDStringArray array)

Appends all of the elements in the specified array to the end of this array.

Parameters:

array - array containing elements to be appended to this array.

fill

public void fill(String element)

Replaces all elements of this array with the same value.

Parameters:

element - element that replaces all elements of this array.

fill

public void fill(int fromIndex, int toIndex, String element)

Replaces a group of consecutive elements of this array with the same value. The group of elements to be replaced
consists of elements whose index is between fromIndex, inclusive, and toIndex, exclusive.

Parameters:

fromIndex - index of the first element to be replaced.

toIndex - index after the last element to be replaced.

element - element that replaces the elements from fromIndex to toIndex.

contains

public boolean contains(String element)

Returns true if this array contains the specified element.

Parameters:

element - element whose presence in this array is to be tested.
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Returns:

true if the specified element is present; false otherwise.

containsAll

public boolean containsAll(SDStringArray elements)

Returns true if this array contains all elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if all specified elements is present in this array; false otherwise.

containsAny

public boolean containsAny(SDStringArray elements)

Returns true if this array contains any one of the elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if any specified elements are present in this array; false otherwise.

sort

public void sort()

Sorts the array in ascending order.

equals

public boolean equals(Object anObject)

Element by element comparison.

Parameters:

anObject - an object to compare this array with.
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Returns:

true if the arrays are equal, false otherwise.

toArray

public String[] toArray()

Returns an array of String containing all elements of this one.

Returns:

an array of double containing all elements of this one.

toArray

public void toArray(String[] array)

Copies elements to a given array. If the supplied array is shorter than the number of elements in this one, only the
elements that fit the supplied array are copied. If the supplied array is longer than the number of elements in this one,
the rear part of the supplied array remains unchanged.

Parameters:

array - the array to which the elements of this one are to be copied.

Throws:

ArrayStoreException - if the runtime type of the supplied array is not a supertype of the runtime type of every element
in this one.

setSize

public void setSize(int size)

Adds or deletes elements at the end of the array.

Specified by:

setSize in class SDArray

Parameters:

size - new number or elements.

Throws:

IllegalArgumentException - if size < 0.
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trimToSize

public void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

Specified by:

trimToSize in class SDArray

toString

public String toString()

Returns a string representation of this array. The string representation consists of elements of the array enclosed in
square brackets ("[]"). Adjacent elements are separated by the characters ", " (comma and space).

Returns:

a string representation of this array.

indexOf

public static int indexOf(String element, String[] array)

Returns the index in an array of the first occurrence of the specified element, or -1 if the array does not contain such
element. This method uses linear search.

ensureCapacity

protected void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.

Specified by:

ensureCapacity in class SDArray

Parameters:

capacity - number of elements to accommodate.

3.11 com.sigmadynamics.util
Class SDStringArray

Type safe implementation of resizable array containing elements of type Object.
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public class SDObjectArray

extends SDArray

Field Detail

buf

protected double[] buf

Constructor Detail

SDObjectArray

public SDObjectArray()

Constructs an empty array.

SDObjectArray

public SDObjectArray (int capacity)

Constructs an empty array with the specified initial capacity.

Parameters:

capacity - the initial capacity of the array.

capacity

public int capacity()

Returns buffer capacity.

Specified by:

capacity in class SDArray

Returns:

buffer capacity.

get



Siebel Decision Studio Reference Guide 98

public double get(int index)

Returns the element at the specified position in this array.

Parameters:

index - index of the element to return.

Returns:

The element at the specified position in this array.

set

public void set(int index, Object val)

Replaces the element at the specified position in this array with the specified element.

Parameters:

index - index of the element to replace.

val - value.

add

public void add(Object element)

Appends the specified element to the end of this array.

Parameters:

element - element to be appended to this array.

addAll

public void addAll(SDObjectArray array)

Appends all of the elements in the specified array to the end of this array.

Parameters:

array - array containing elements to be appended to this array.

fill

public void fill(Object element)
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Replaces all elements of this array with the same value.

Parameters:

element - element that replaces all elements of this array.

fill

public void fill(int fromIndex, int toIndex, Object element)

Replaces a group of consecutive elements of this array with the same value. The group of elements to be replaced
consists of elements whose index is between fromIndex, inclusive, and toIndex, exclusive.

Parameters:

fromIndex - index of the first element to be replaced.

toIndex - index after the last element to be replaced.

element - element that replaces the elements from fromIndex to toIndex.

contains

public boolean contains(Object element)

Returns true if this array contains the specified element.

Parameters:

element - element whose presence in this array is to be tested.

Returns:

true if the specified element is present; false otherwise.

containsAll

public boolean containsAll(SDObjectArray elements)

Returns true if this array contains all elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if all specified elements is present in this array; false otherwise.
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containsAny

public boolean containsAny(SDObjectArray elements)

Returns true if this array contains any one of the elements of the specified array.

Parameters:

elements - elements whose presence in this array is to be tested.

Returns:

true if any specified elements are present in this array; false otherwise.

sort

public void sort()

Sorts the array in ascending order.

sort

public void sort(Comparator c)

Sorts the array of objects according to the order induced by the specified comparator.

Parameters:

c - the comparator to determine the order of the array. A null value indicates that the natural ordering of the elements
should be used.

Throws:

ClassCastException - if the array contains elements that are not mutually comparable using the specified comparator.

See Also:

Comparator

equals

public boolean equals(Object anObject)

Element by element comparison.

Parameters:

anObject - an object to compare this array with.
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Returns:

true if the arrays are equal, false otherwise.

toArray

public Object[] toArray()

Returns an array of Object containing all elements of this one.

Returns:

an array of double containing all elements of this one.

toArray

public void toArray(Object[] array)

Copies elements to a given array. If the supplied array is shorter than the number of elements in this one, only the
elements that fit the supplied array are copied. If the supplied array is longer than the number of elements in this one,
the rear part of the supplied array remains unchanged.

Parameters:

array - the array to which the elements of this one are to be copied.

Throws:

ArrayStoreException - if the runtime type of the supplied array is not a supertype of the runtime type of every element
in this one.

setSize

public void setSize(int size)

Adds or deletes elements at the end of the array.

Specified by:

setSize in class SDArray

Parameters:

size - new number or elements.

Throws:

IllegalArgumentException - if size < 0.
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trimToSize

public void trimToSize()

Removes any excess buffer capacity above the actual number of elements.

Specified by:

trimToSize in class SDArray

toString

public String toString()

Returns a string representation of this array. The string representation consists of elements of the array enclosed in
square brackets ("[]"). Adjacent elements are separated by the characters ", " (comma and space). Elements are
converted to strings by String.valueOf(Object).

Returns:

a string representation of this array.

indexOf

public static int indexOf(Object element, Object[] array)

Returns the index in an array of the first occurrence of the specified element, or -1 if the array does not contain such
element. This method uses linear search.

ensureCapacity

protected void ensureCapacity(int capacity)

Grows the internal buffer as needed to accommodate the specified number of elements.

Specified by:

ensureCapacity in class SDArray

Parameters:

capacity - number of elements to accommodate
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3.12 Data types in Studio
The metadata defined in studio for the following data types result in these Java classes being generated.

Metadata Type Generated Java Type

String String

Double double

Date long. This number represents the
number of milliseconds since
midnight January 1, 1970

Boolean Boolean

Integer int

Java Class Name Java Class Name

<Choice> (specific) <Choice Group ID>Choice

<Choice Group> (specific) <Choice Group ID>

Choice (generic) Choice

Choice Group (generic) Choice Group

Entity ID <Entity ID>
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Section 4: About testing and deploying an Inline Service
Once you have configured you Inline Service, you deploy it locally or to a test environment for testing. You can deploy
an Inline Service in two different states: QA and Production.

You can first deploy in the QA state, and then after testing into Production state. When you deploy to Production state,
check the Release Inline Service locks check box. Once the Inline Service is deployed to business users, they can
also update and redeploy the Inline Service.

Deploy the Inline Service using the Project→Deploy menu item or the Deploy button on the task bar. The
deploy dialog give several options:

Note: You must have the proper permissions on the server cluster to
deploy an Inline Service. For more about cluster permissions, see Installation
and Administration of Siebel RTD.

Project Choose the project that you will deploy to the Siebel Real-Time Decision Server.

Inline Service The Inline service contained in this project.

Study Name Enter a Study Name for this Inline Service. Each Inline Service's learnings are
associated with a Study Name. If you would like to re-deploy and Inline service
and re-start its learnings, deploy it with a new Study Name. One Study Name can
be used for QA and another for Production.

Deployment State The default deployment states of Inline Services are Development, QA or
Production. Deployment state marks an Inline Service that is in development,
testing or production so that others are aware of its state.

Your system administrator may have created custom deployment states.
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Server Use this button to enter the server and port you would like to deploy to. The
Server dialog box will require you to provide a valid username and password that
has deployment authorization on the server cluster you are deploying to. Cluster
authorization is granted via the JMX Console by your administrator.

Release Application Lock A deployed Inline Service is automatically locked and only the user who deployed
it is able to re-deploy the Inline Service. Once you have completed development
and testing and are deploying the Inline Service for production, check the
Release Application Lock box to allow Decision Center users to make changes
and re-deploy the Inline Service.

Terminate Active Sessions If the Inline Service you are deploying is in production, there may be active
sessions. If a new version of the Inline service is deployed while there are active
sessions, the older version will be maintained to service those sessions. Check
this box to terminate the active sessions if you are in testing. For a production
Inline Service, leave unchecked so that any active sessions will continue to run
on the production version of the Inline Service. New sessions will be routed to the
new version and the old version will terminate when all active sessions have
completed.

Do not activate after
deployment

Use this option to deploy the Inline Service to the server, but not start the
process. If you would like to activation the Inline Service at a later date, use the
JMX Console. For more information about the JMX Console, see Installation and
Administration of Siebel RTD.

4.1 Connecting to the Siebel Real-Time Decision Server
When deploying or downloading Inline Services or importing Data Sources you connect to the Siebel Real-Time
Decision Server. To connect, use the username and password you created on installation or consult your Administrator
for your username and password. To connect in a secure manner using https, check Secure connection .
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4.2 About redeploying Inline Services
If you are going to make changes to a deployed Inline Service, it is important to follow these practices in order to
preserve both your changes and the potential changes that have been made by the business user. If you are making
changes to a deployed Inline Service, you can download it from a Siebel Real-Time Decision Server using the
download icon on the toolbar. Use the following method:

1. Make sure that no business users are editing the deployed Inline Service.

2. You should always lock an Inline Service when you download, so that additional changes cannot be
made by business users while you are enhancing it.

3. Make enhancements in Studio.

4. Re-deploy the Inline Service releasing the locks.

During the period that you have the Inline Service locked business users will be able to view, but not edit, the deployed
Inline Service.

4.3 Testing your Inline Service
In order to test your inline Service you can generate data using the Load Generator. To access the Load Generator
use Start→Siebel Analytics→RTD→Load Generator. For a sample load generator script, see the etc directory of
the Cross Sell example.

4.3.1 About Load Generator

Load Generator is a tool used for debugging and benchmarking Inline Services by simulating users. Load Generator is
used both for testing the Inline Service and for performance characterization.

Load Generator has four tabs:

 Run: runs a load generator session and gives feedback on the performance through measurement and
graphs.

 General: sets the general settings for Load Generator’s operation, including the rate in which data is sent to
the server and the location of the client configuration file.

 Variables: used to create script, message and access variables.

 Edit Script: used to set up the script that specifies the integration point requests to be sent to the server.

Using Load Generator for testing

Load Generator is used to generate load on the server which is tested for performance and scalability. Intelligently
random messages are sent to the Inline Service allowing the models to learn. The capability of your models can be
gauged after running Load Generator for a sufficient period of time.

Using Load Generator for performance characterization

Once an Inline Service is configured, Load Generator is used to evaluate how the service performs under load in order
to assess how many servers are needed for specific loads. When it is desired to stress the server, usually one instance
of Load Generator running on one client machine is sufficient to do so, because Load Generator can engage many
threads of execution to run multiple scripts concurrently. If additional load is desired and Microsoft Task Manager
shows that Load Generator is already consuming the majority of the client’s processing power, then several instances
of Load Generator can be started in several client machines and pointed to one server. They send messages with
some intelligently random generated messages in the context of sessions. The clients measure performance statistics
as well as the server.
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4.3.2 Running a Load Generator Session

To start a session, first create a new script or load an existing one. Then select the Run option from the Run menu or
press the Run button on the toolbar. You can alter the delay between data samples on the General tab.

Measuring the server load

The Run tab displays real time information about the session running. It displays the following information:

New Requests The number of requests that have been closed since the previous data sample
was taken.

New Errors The number of errors, either client or server side, that have occurred since the
previous data sample was recorded.

New Default Responses The number of errors since the last data sample, that occurred for Advisor
Integration Point Requests (as opposed to Informant Integration Point Requests)
and a default response was defined by the Inline Service for the Advisor.

Active Scripts Number of simulated users currently connected to the server from this load
generator.

Peak Response Time The length of time it took to close the oldest request during the current data
sample.

Total Requests The total number of requests that have been closed.

Total Errors The total number of errors.

Total Default Responses The total number of default responses.

Total Finished Scripts The total number of simulated users.

Average Script Duration The length in milliseconds of an average script’s execution, from start to finish.

4.3.3 Viewing Performance Graphs

By default, the Requests per Second graph is visible. You can hide and show graphs using the View→Graphs. To

clear the data in the graphs, use Clear Graphs on the toolbar or use View→Clear Graphs .

If you stop a script and restart it, all recorded data will be cleared. However, if you pause a session and then start it
again, the data will not be cleared. The following Graph are available:

Average Response Time A histogram depicting the 40 most recent average response times.

Errors A line graph depicting the number of errors that occurred within the most recent
12000 data samples.

Peak Response Time A line graph depicting the peak response time, in milliseconds, that occurred
within each of the most recent 12000 data samples.

Requests Per Second A line graph depicting the average number of requests per second that occurred
within each of the most recent 12000 data samples.
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Requests Per Second
distribution

A histogram depicting the 40 most recent readings for requests per second.

4.3.4 About the General tab

The General tab contains variables about the Load Generator's configuration, timing and which Inline Service is being
specified. The General tab has the following variables:

Load Generator

Client Configuration Describes which endpoints the load generator should use
to contact the server.

Graphs Refresh Interval in Seconds Sets the delay between graph and counter updates.
Press the Apply button for settings to take effect while a
script is already running.

Details

Inline Service The name of the Inline Service this script will send
requests to.

Random Number Generator Seed If your script has any random elements in it, this gives
you the ability to reproduce, to some extent, the random
behavior. Repeatable randomness is not possible when
running more than one concurrent script (see Scripts
section below, the item titled Number of Concurrent
Scripts to Run.)

Think Time

Fixed Global Think Time A single number, in seconds, that all simulated users will
wait between requests.

Ranged Global Think Time

Minimum A nonzero number of seconds to wait at a minimum.

Maximum A nonzero number of seconds to wait at a maximum
(greater than minimum).

Access Type Sequential At each access, increase the think time by one until you
reach the maximum when it will reset to the minimum.

Access Type Random At each access, choose a value between minimum and
maximum, inclusive of each.

Scripts

Number of Concurrent Scripts to Run The number of simultaneous users to simulate.
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Maximum Number of Scripts to Run A positive number in this field causes the load generator
to stop running after that number of sessions have
completed. Zero means unlimited.

Logging

Enable Logging When checked, Load Generator statistics data is written
to a file periodically.

Append to Existing File When checked, and logging is enabled, Load Generator
will append new statistics data onto the end of an existing
log file, if any, else it will create a new file.

Log File The full path to the log file, a tab separated file whose
contents is described below.

Logging Interval in Seconds The number of seconds to wait after appending values
onto the log file before writing the next set of values.

4.3.5 About Variables

Variables allow a load simulation to draw its input from many different sources. Session variables are generated once
per session. Subsequent accesses to a session variable use the same value. Message variables are held constant for
a single request. Access variables may vary every time they are read. Variables are used in Message Actions.

Using Variables

To use a variable in a message for a value to a parameter you may simply select it from the dropdown. However if you
wish to use it as part of a larger string value, you can surround the variable name with braces, e.g., {customerNum}.

4.3.6 Types

There are five types of variables.

Constant Value A constant value.

Integer Range Select an integer from a range

Example: Minimum: 0, Maximum: 50000, Access Type:
Random

Minimum: 0, Maximum: 1, Access Type: Sequential

String Array Select a string from the specified array.

Example: List: [A, B, C], Access Type: Random

List: [Male, Female], Access Type: Sequential

Weighted String Array Select from the specified array a string with some
likelihood (0,1]

Example: List: [[0.3, Interested], [0.3, Accepted], [0.4,
Rejected]] List: [[0.999, Interested], [0.001, Accepted]]
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Text File Select a line of text from a file.

Examples:

c:/data.txt, Access Type: Sequential -- an absolute
reference to a file on the C: drive.

inbox/data.txt, Access Type: Random -- a relative
reference to a file in the inbox directory, under
the directory containing the script file.

4.3.7 About Actions

In order to easily simulate multiple clients supplying realistic loads to the server messages can be generated from
patterns specified in metadata that are interpreted by the load generator at runtime. The patterns specify message
sequences, with fixed or random inter-message delays (think times), as well as patterns for generating values for
message fields. Message field values can be literal strings, with optional embedded random characters, or they can be
randomly selected from a set of values associated with the field. Sessions are supported, allowing certain fields to
remain constant across messages of the session, suitable for representing session keys – e.g. a customer ID, call ID,
or account number. The patterns allow some flexibility in the sequencing of messages. For example, in a typical
session certain messages will come before others, or a predetermined number of messages of certain kind need to
happen, etc.

Types of Actions

There are two types of Actions: Message and Loop.

Message has the following attributes:

Integration Point name The name of the Integration Point that will be sent the message.

Session Keys and values The values sent to the integration point Request. Session keys
have to be separated from other message fields because the server
uses them for routing.

Loop has the following attributes:

Number of times to execute Can be constant value or a range value. A range value executes
either sequentially or randomly within the range.

4.3.8 Load Generator CSV log file contents

This section describes the fields of the CSV file containing load generator statistics.

Date/Time The time of day at which the current row of counters was appended to the file. Millisecond
precision is available to facilitate correlations with messages in the server’s log file.

Thread Pool Size The number of threads engaged or available to run scripts. This is an implementation detail
of little to interest to most people.

New Requests The number of requests that have been closed since the previous data sample was taken.
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Total Requests The total number of requests that have been closed.

New Errors The number of errors, either client or server side, that have occurred since the previous data
sample was recorded.

Total Errors The total number of errors.

New Default
Responses

The number of errors since the last data sample, that occurred for Advisor Integration Point
Requests (as opposed to Informant Integration Point Requests) and a default response was
defined by the Inline Service for the Advisor.

Total Default
Responses

The total number of default responses.

Active Scripts Number of simulated users currently connected to the server from this load generator.

Total Scripts The total number of simulated users.

Average Response
Time (ms)

The average length of time it took to close the oldest request during the current data
sample.

Max Response Time
(ms)

The largest length of time it took to close the oldest request during the current data sample.

Average Script
Duration (ms)

The length in milliseconds of an average script’s execution, from start to finish.

Snapshot Period
(ms)

The number of milliseconds over which the current counter values were accumulated.

4.3.9 XLS file contents

This section describes the contents of the Microsoft Excel file, lg_perf.xls, included in the installation’s etc directory for
purposes of rendering the Load Generator counters written, typically, to log/loadgen.csv.

At the top, cell A1 contains a comment describing how to link lg_perf.xls to the tab separated counter file as a
datasource:

To specify the path to the Load Generator performance log, place cursor the in cell A2 and select "Import
External Data" > "Edit Text Import" from the "Data" menu, and navigate to the path specified in your loadgen
configuration, typically {$install_directory}\log\loadgen.csv. Use default parsing settings when prompted.
Data will then be automatically refreshed every 3 minutes. To change interval and other settings, select from
the "Data" menu the selection "Import External Data" > "Data Range Properties".

In row 2 are the headers containing the names of each counter. All of the headers from the CSV file, described above,
appear hear, with values below them.
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Section 5: Troubleshooting and debugging Inline Services
Siebel RTD provides services to assist in troubleshooting and debugging your Inline Service. While developing your
Inline Service several methods may assist you in debugging including interactive error location and validation, and a
built in test bed for your Inline Service.

Once deployed, the Siebel Real-Time Decision Server can be run in debug mode to set breakpoints in your Inline
Service.

5.1 About the problem pane
The Problem pane identifies compilation errors and validation errors as the Inline service is built. Double-click on a
compilation error and the Java perspective appears with the error highlighted.

Double-click on a validation error and the Inline Service perspective appears with the element editor for the element
that has validation errors.

5.2 Using the test pane
Siebel Decision Studio includes a test pane where you can test individual Integration Points. The Test pane allows you
to simulate the operational system(s) that will call the Integration Points. The Test pane has a drop-down menu of all
Integration Points in the Inline Service. To test the Integration Point, insert values for the session key and Request
Data and use the run button to run. Three sub-tabs give information about the Integration Point: Results, Trace, and
Log.

The Results tab shows the results of calling an Advisor Integration Point. Only Advisors return results. For testing
Informants and for debugging both kinds of Integration Points, use logInfo().

You can use the statementlogInfo()at various points in your code as a debugging device. This is helpful to use
in elements such as Advisors or Informants, Decisions, Functions, etc. Insert the statement into the logic pane of the
element and use it as a device to display in the log data at different stages.

5.2.1 Using logInfo( )

The Log tab gives a view of all logInfo()statements.

The logInfo method is part of the logging API described in section 3.2 com.sigmadynamics.support
Class SDOBase. This class contains methods for logging messages at the informational, debug, warning and error
levels. These logging methods generally accept a string and another argument as parameters.

Two examples of using logInfo are shown below:

logInfo("Installation date = " +
DateUtil.toString(session().getCustomer().getInstallationDate());

logInfo("Customer age = " + session().getCustomer().getAge() );

5.2.2 Testing for incoming request data

When testing an Integration Point, you can check for the incoming request data using the following methods.

If the incoming parameter is mapped to a session attribute, there is aget method for the parameter.

request.get$()
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where $ is the parameter name with the first letter capitalized.

If the attribute is not mapped, there are methods to achieve the same results using the field name of the parameter.

String request.getStringValue(fieldName)

SDStringArray request.getStringArrayValue(fieldName)

boolean request.isArgPresent(fieldName)

Outgoing response data is always stored in a SDChoiceArray:

SDChoiceArray choices = null;

The Decision is executed by the Integration Point, and the Choice is stored:

if (session().isControlGroup()) {

choices = RandomChoice.execute();

} else {

choices = SelectOffer.execute();

}

To find out what the Choice is, you can get them from the array and usegetSDOId or getSDOLabel.

if (choices.size() > 0) {

Choice ch = choices.get(0);

ch.getSDOId();

}

The best place to do this is in the Post Selection Logic of the Decision. After the Decision executes, the post selection
login will run.

5.3 Using system logs
Siebel RTD has two logging locations.

Log Default Location

Siebel Real-Time Decision Server log; this can be
viewed from Eclipse using the Error Log view from the
Window menu.

$INSTALLDIR\log\server.log

Eclipse log $INSTALLDIR\eclipse\workspace\.metadata\.log

5.3.1 Setting logging levels

To set the logging levels for Eclipse make changes to the file
$INSTALLDIR\eclipse\plugins\com.sigmadynamics.studio_2.1.0\etc\eclipse-log.properties.
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To adjust logging levels, set the following values to true or false. The default settings are show below.

 debug=false

 info=true

 warn=true

 error=true

 fatal=true

 trace=false

To change logging options for the Siebel Real-Time Decision Server log, use the JMX Administration console. For
more information on the JMX Console, see the Installation and Administration of Siebel RTD.

5.4 Using Performance Monitoring
Siebel RTD includes a robust performance monitoring system for observing the behavior of Inline Services.
Performance Monitoring parameters are set and a snapshot view of some of the common counters can be observed
through the JMX Administration console. A chronological view can be obtained by enabling the performance monitor.
Once enabled, a comma separated value (CSV) file will be produced that can be used to observe behavior over time.

Warning: This file grows without limit and should be enabled only for
active troubleshooting.

5.4.1 Setting performance monitoring parameters

The performance monitoring parameters are set using the MBean, SDManagementCluster → Members → Properties
→ PerformanceMonitoring. The following table describes the properties governing performance monitoring.

For more information on the JMX Console, see the Installation and Administration of Siebel RTD.

DSPerfCounterEnabled Enables the writing of DS performance counters.

Should not be enabled indefinitely, because the file grows
without limit.

DSPerfCounterAppend If true, performance data is appended to an existing file, if
any, otherwise any existing file is overwritten when the
server restarts.

DSPerfCounterLogFile The tab-separated CSV file into which DS performance
counts are periodically appended. If MS Excel is available,
ds_perf.xls, supplied in the installation's etc directory,
provides a convenient view. See the first row of ds_perf.xls
for instructions on linking ds_perf.xls to ds_perf.csv as a
datasource.

DSPerfCounterLogInterval The update interval in milliseconds for DS performance
counts.
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5.4.2 Viewing common performance monitoring snapshot values

A snapshot of some of the performance counters is available for viewing through the MBean
SDManagementCluster→Members→Decision Server. Use the F5 key to refresh the values.

Performance monitoring does not have to be enabled to use this view.

5.4.3 CSV file contents

This section describes the fields of the CSV file containing performance counters.

Date/Time The time of day at which the current row of counters was appended to the file. Millisecond
precision is available to facilitate correlations with messages in the server’s log file.

The maximum number of Inline Service requests that can be allowed to run concurrently.

The value is derived from configuration settings. It should be chosen to minimize the
operating system’s thread scheduling overhead, and hence provide maximum throughput for
a busy system.

The value can be set manually, by setting a non-zero value in either the cluster-wide
configuration property,

SDManagementCluster→Properties→Misc→
IntegrationPointMaxConcurrentJobs

or in the server-specific property,

SDManagementCluster→Members→Properties→Misc→
IntegrationPointMaxConcurrentJobs.

The preferred value is chosen by setting the property to zero, in which case the value is
calculated according to the following formula.

NumCPUs * Math.ceil(1/(1 -DSRequestIOFactor)) + 5

The formula uses these terms:

NumCPUs Server -specific configuration property

SDManagementCluster→Members→Properties→
Misc→NumCPUs

Use the number of physical CPUs in the machine.

Math.ceil Means “round up to the next higher integer value”.

Max Allowable
Running Requests

DSRequestIOFactor Server -specific configuration property

SDManagementCluster→Members→Properties→
Misc→IntegrationPointRequestIOFactor

The fraction of time Integration Point requests spend doing
input/output operations, or otherwise waiting for systems external
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to this virtual machine. The default value is 0.5.

Peak Requests
Running

The largest number of requests that have been running at the same time since the server
was started.

Max Requests
Running

The largest number of requests that have been running at the same time during the current
logging interval.

Requests Running The number of inline service requests that are currently running. This value will always be
less than or equal to the Max Allowable Running Requests value.

Request Queue
Capacity

The configured maximum number of requests that can wait at the same time in this server to
run. This is the value of the cluster-wide property,

SDManagement -Cluster→Properties→Misc→IntegrationPointQueueSize

or the server -specific property,

SDManagement -Cluster→Members→Properties→Misc→
IntegrationPointQueueSize

When a request arrives and the request queue is full, the request is rejected and a “Server
Too Busy” error is logged in the server.

The property should be set to a value just a few smaller than the number of concurrent
HTTP requests (threads) supported by the web server, otherwise the request queue could
never fill up because the requests would be rejected first by the web server.

Peak Queue Length The largest number of inline service requests that have been waiting at the same time to run
in this server since the server started. This will always be less than or equal to “Request
Queue Capacity”, described above.

Max Queue Length The largest number of inline service requests that have been waiting at the same time to run
in this server during the current logging interval. This will always be less than or equal to
“Request Queue Capacity”, described above.

Requests Waiting
(Queue Length)

The number of inline service requests that are currently waiting to run.

Requests When
Queue Full, Total

The total number of requests that have arrived while the server’s request queue was full.
Each of these requests was rejected with a “Server Too Busy” error.

Requests Queued,
Total

The total number of inline service requests that were required to wait to run until other
requests finished running.

If all requests are being queued, the system is very busy.

Requests Seen, Total The total number of inline service requests seen by this server.

Requests In System The current number of inline service requests being processed by this server. The number
includes those waiting to run and those already running.

Timed Out Requests,
Total

The total number of requests that have failed to finish running before their guaranteed
service level timeout, as specified by cluster-wide property:
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SDManagementCluster→Properties→Misc→
IntegrationPointGuaranteedRequestTimeout

This count includes all timed out requests since the server was started.

If this number is growing but the number of queued requests is not growing, this is an
indication that the Inline Service logic handling the request is too slow to satisfy the
response time guarantee even on an idle system. One or more integration point requests
must be optimized, or the response time guarantee must be increased.

Timed Out Requests The number of requests that failed to finish running before their guaranteed service level.

Timed Out While
Running, Total

The total number of requests, observed since the server started, to have started running and
not finish within their response time guarantee.

The server’s processing power consumed by these requests is largely wasted, because the
clients will ignore their late responses. When the system is very busy, it sometimes times out
requests that are still waiting to run, thus avoiding wasting resources on them.

Timed Out While
Running

The number of requests, observed during the current logging interval started, to have started
running and not finish within their response time guarantee.

The server’s processing power consumed by these requests is largely wasted, because the
clients will ignore their late responses. When the system is very busy, it sometimes times out
requests that are still waiting to run, thus avoiding wasting resources on them.

Timed Out Requests
Still Running

The number of requests that have started running, timed out, and are still running. A non-
zero value could be an indication of a programming problem in one or more integration
points.

Request Run Time,
Average (ms)

The average time, in milliseconds, during the current logging interval that requests ran.
Excludes wait time, if any.

Request Run Time,
Max (ms)

The largest amount of time, in milliseconds, during the current logging interval, that any
single request ran. Excludes wait time, if any.

Run Times < [0.1
GRT]

The number of requests that finished running during the current logging interval and ran less
than 10% of the configured guaranteed response time.

There are nine similarly formatted columns, showing the run time distribution for 0.10, 0.25,
0.50, 0.75, 1.00, 1.25, 1.50. and 2.0 times the guaranteed response time.

Run Times < N and
>= M

The number of requests that finished running during the current logging interval and ran less
than N milliseconds and greater than or equal to M milliseconds.

Run Times >= [2.0
GRT]

The number of requests that finished running during the current logging interval and ran two
or more times the configured guaranteed response time.

Request Wait Time,
Average (ms)

The average time, in milliseconds, that requests waited on the request queue prior to
running or timing out.

Includes only those requests that finished running, or timed out before running, during the
current logging interval.
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Request Wait Time,
Max (ms)

The largest amount of time, in milliseconds, during the current logging interval, that any
single request waited on the request queue.

Includes only those requests that finished running, or timed out before running, during the
current logging interval.

Wait Times < [0.1
GRT]

The number of requests that finished running during the current logging interval, and were
placed on the request queue before running, but waited there less than 10% of the
configured guaranteed response time.

There are nine similarly formatted columns, showing the wait time distribution for 0.10, 0.25,
0.50, 0.75, 1.00, 1.25, 1.50. and 2.0 times the guaranteed response time.

Wait Times < N and
>= M

The number of requests that finished running during the current logging interval and waited
on the request queue less than N milliseconds and greater than or equal to M milliseconds
before running.

Wait Times >= [2.0
GRT]

The number of requests that finished running during the current logging interval and waited
two or more times the configured guaranteed response time before timing out.

Sessions, Current The number of Decision Server sessions still open in this server.

Sessions, Total The total number of Decision Server sessions created by this server.

Stale Sessions
Closed
Asynchronously

The total number of Decision Server sessions that have been closed by kernel jobs, instead
of by request threads.

This is usually unimportant. In a busy system, most stale sessions are closed by request
threads and the kernel jobs are engaged only as the system winds down. It could be of
interest to someone observing a lot of kernel-job activity (see “Kernel Jobs Running,
Current”).

Stale Sessions
Closed by Requests

The total number of Decision Server sessions that have timed out and been closed by
request threads. Most sessions will be closed this way, especially on a busy server.

After processing an inline service request, the calling thread will be asked to close at most
one stale session before returning to the caller.

Requests Forwarded,
Total

The total number of inline service requests that this server has forwarded to a different
server because a session key in the request is currently being hosted by a different server.

A non-zero number is an indication that the application server or external load balancer is
not perfectly routing requests to servers in a way that assures session affinity. This is OK,
but performance can be improved by tuning the application server’s session affinity
parameters or acquiring an external load balancing system.

Remote Session
Keys, Current

The current number of session keys that this server knows reference sessions hosted by
other servers. If a request arrives with one of these keys, it will be forwarded to the other
server.

Remote Session
Keys, Total

The total number of times that session keys were registered in this server for sessions
hosted by other servers. This is an aggregation of “Remote Sessions Keys, Current”.

Kernel Jobs Running, The number of maintenance activities currently running in the server. Maintenance activities
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Current include model maintenance, session timing, and timed-out request processing.

Kernel Jobs Running,
Peak

The largest number of maintenance activities that have run at the same time in this server.
This value will always be less than or equal to the cluster -wide property,

SDManagement -Cluster→Properties→Misc→WorkerThreadPoolSize

or the server -specific property,

SDManagement -Cluster→Members→Properties→Misc→WorkerThreadPoolSize.

Snapshot Period (ms) The period of time, in milliseconds, over which the server collected data before logging this
row of counters.

5.4.4 XLS file contents

This section describes the contents of the Microsoft Excel file, ds_perf.xls, included in the installation’s etc directory.

At the top, cell B1 contains a comment describing how to link ds_perf.xls to the tab separated counter file as a
datasource:

To specify path to the ds_perf.csv file, place cursor in cell B2 and select "Import External Data" > "Edit Text
Import" from the "Data" menu, and navigate to your {$install_directory}\log\ folder and select the ds_perf.csv
file. Use default parsing settings when prompted. Data will then be automatically refreshed every 3 minutes.
To change interval and other settings, select from the "Data" menu the selection "Import External Data" >
"Data Range Properties"

In row 2 are the headers containing the names of each counter. All of the headers from the CSV file appear hear, with
values below them.

After the values from the CSV file, are the following columns, with formulas showing values calculated from the CSV
values:

Gross Throuhput
(req/sec)

The average rate of requests finishing during the current logging interval, in requests per
second.

The formula is: RequestsFinished / SnapshotPeriod * 1000.

Net Throughput
(req/sec)

The average rate of requests finishing during the current logging interval, excluding requests
that timed out.

The formula is: (RequestsFinished - Timeouts) / SnapshotPeriod * 1000

Utilization (%) The percentage of the server’s capacity utilized during the current logging interval.

The formula is: (RunTimeAverage * RequestsFinished) / (MaxAllowableRunningRequests *
SnapshotPeriod) * 100.

This value can be briefly larger than 100 when requests are finishing that started running in
previous logging intervals.
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5.5 Error messages and exceptions
The following exceptions may appear in your log. Suggested actions are shown with each. If these actions do not
resolve your problem, contact your Siebel Systems support representative.

Exception Action

Error reading file <filename> Check that the file exists and has read permissions.

Error writing file <filename> Check that the file exists and has write permissions.

Cannot load Inline Service with id <id>. No Decision
Service is present.

Check that the server where the Decision Service is
deployed is running. Use the JMX Console to find where the
Decision Service is deployed. For information about
Administration (JMX), see Installation and Administration of
Siebel RTD.

Failure setting up Smart Client's default responses
from file, <filename>

Check the Smart Client properties file for the location of the
file and check to make sure it exists.

Error connecting to server Check your server connectivity and that your network is
working properly.

There were compiler errors\: <errors> Compiler errors may occur on the server if you have
configured an Inline Service in a newer version of Studio than
the version of the Server. Upgrade your Server version to
correct the problem.

Internal Error. Contact your Siebel Systems Technical Support
representative.

No default choice is defined for Inline Service <Inline
Service name>, or it's Integration Point <Integration
Point name>.

Default choices are choices used by the calling application
when the server is unavailable. Default choices are defined
at the Integration Point level.

Could not create a backup of {0} in {1} If the backup location is on your network, check the network
connectivity. If the backup location is local, check that you
have enough disk space for the backup.

Could not find JMX Server <server name> If the JMX Server is unavailable, check the database
connectivity and make sure the server is running.

Unknown Decision Service message type received
by HTTP endpoint\: <endpoint name>

Refer to Integration with Siebel RTD for examples and
specifications for HTTP queries.

Malformed SOAP query Refer to Integration with Siebel RTD for examples and
specifications for SOAP queries.

Session merging not implemented, but found two
keys in same request referencing different sessions

Session merging is not yet implemented. In your Inline
Service use only one session key.
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Exception Action

Input column at location <table or stored procedure>
and name <column name> has a null value which is
not supported in where clauses

The Input column of a where clause cannot be null. Go to the
data source indicated and provide a value for the column.

The current server <server> has a newer version of
the metadata so <Inline Service> cannot be loaded

This error can occur if you are using a newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

The current server <server name> supports
metadata versions up to <version number> but the
metadata of <Inline Server> is at version <version
number>

This error can occur if you are using a newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

Generation of Inline Service "<Inline Service name>"
failed

This error can occur if you are using a newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

Unable to read a study definition created by a newer
version of the software.

This error can occur if you are using a newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

Unable to read a prediction model created by a
newer version of the software.

This error can occur if you are using a newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

Encountered a database record created by a newer
version of the software.

This er ror can occur if you are using a newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

Unable to read a learning model created by a newer
version of the software.

This error can occur if you are using an newer version of
Siebel Decision Studio with an older version of Siebel Real-
Time Decision Server. Upgrade your server to correct the
error.

No result set found while getting result set of
procedure "<stored procedure name>".

This error can occur if you have defined a result set for your
data source, but there is none on the stored procedure.
Check the stored procedure definition in the database.

Generic Exception caught while setting blob for
procedure "<stored procedure name>".

This error may occur for several reasons. Check your
database connectivity. Check that the database server is
running.

Exception during output of batched statements\:
database <insert, update, select, delete> operation
for <table or stored procedure> took <duration>.
Batch size is <number of results> .

This error may occur for several reasons. Check your
database connectivity. Check that the database server is
running.
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Exception Action

The stored procedure "<stored procedure name>"
was not found in database.

This error may occur for several reasons. Check your
database connectivity. Check that the database server is
running. Finally, check that the stored procedure named in
the data source is named correctly and resident on the
database.

Failed to find column "<column name>" in table
"<table name>".

This error may occur for several reasons. Check your
database connectivity. Check that the database server is
running. Finally, check that the table named in the data
source is named correctly and resident on the database.

Error setting up Smart Client properties. This error may occur if you haven't properly configured your
Smart Client properties file. Refer to Integration with Siebel
RTD for information on using the Smart Client.

Failed to load Inline Service\: <Inline Service name> This error may occur on startup of the Siebel Real-Time
Decision Server. Redeploy the Inline Services that did not
startup. If the error reoccurs, contact technical support.

The following Errors may be given to you during development.

Error Explanation

Internal error in code generator. See error log for
details.

Check the Problems pane in Studio for errors. If none are
apparent, contact Siebel Systems technical support.

Cannot get <Inline Service> from the database. Will
mark it invalid

Check to make sure that the database server is running, you
have the proper drivers and that you have connectivity to the
database server.

Error loading Inline Service <Inline Service Name>.
Will mark it as invalid in the database.

If you get an error from the server on loading your Inline
Service check to see if the logic in your Application Initialization
logic and Session Initialization logic is correct.

Response for an asynchronous request to advisor
"<Advisor name>" will not be sent

If you want a response from an Advisor, you must use the
invoke( ) method, not invokeAsync( ).

Invoke failed Make sure that you have connectivity to the Siebel Real-Time
Decision Server. Check that your properties file is properly
configured. For more information on using Invoke, refer to
Integration with Siebel RTD.

Internal error Please call Siebel Systems technical support.

Internal error while generating code for <Inline
Service>.

Please call Siebel Systems technical support.

Error in Application Session Cleanup. This error can be caused by incorrect logic in the Application
and Session elements. Check to see if the logic in your
Application Cleanup logic and Session Cleanup logic is correct.
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Error Explanation

Failed to load study "<study name>" This error may be caused by database connection issues.
Check to make sure that the database server is running, you
have the proper drivers and that you have connectivity to the
database server.

Failed to save study "<study name>". This error may be caused by database connection issues.
Check to make sure that the database server is running, you
have the proper drivers and that you have connectivity to the
database server.

Failed to load prediction model "<model name>" This error may be caused by database connection issues.
Check to make sure that the database server is running, you
have the proper drivers and that you have connectivity to the
database server.

Error delivering response message\: <error details> Your invoke( ) on the Integration Point may have timed out.
Check the timeout setting in the properties file. For more
information on using invoke( ), refer to Integration with Siebel
RTD.

Product sdstudio could not be found. This error message is simply informational and can be ignored.
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